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How to upgrade to Windows 
10: What you need to know
Now that we know when and how Microsoft plans to upgrade consumers 
to Windows 10, in detail, we can pass that advice along to you. Here’s our 
guide to making the big move.

Tech and trends that will affect you today and beyond. NEWS

BY MARK HACHMAN
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eginning July 29, Windows 7 and Windows 8.1 users will be 
able to download Windows 10. It’s a monumental shift for 
both Microsoft and its customers. But Microsoft has 

provided a wealth of information to ease the transition, and let you 
upgrade to Windows 10 as simply and easily as possible.

For consumers, the choice is a simple one: You’ll be upgraded to 
one of two versions of Windows 10: Windows 10 Home, or Windows 
10 Professional. (This guide doesn’t cover the upgrade process to 
Windows 10 Mobile for phones.) Microsoft has also released the 
official retail pricing for Windows 10 (go.pcworld.com/win10cost), in 
case you’re building your own PC.

During the update process, plan to invest some time in prep work 
and at least an hour in the upgrade process itself. And be careful—
some of your applications may be left behind. 

Aside from one major component of some versions of Windows 7, 
however, the transition between the earlier versions of Microsoft’s 
operating system and the new Windows 10 should be relatively 
painless. Basically, if you own a Pro version of Windows, you’ll migrate 
to the Professional version of Windows 10. Otherwise, expect to 
receive a copy of Windows 10 Home. 

Besides this story, a good reference is Microsoft’s Windows 10 FAQ 
itself (go.pcworld.com/win10FAQ), which explains, for example, what 
the Windows 10 reservation app is, how it works, whether you can 
update more than one Windows PC (yes) and whether you can cancel 

B
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your reservation (also yes). Also, it offers one piece of important 
advice: You must be running a genuine, licensed copy of Windows. 

Windows 10 prep work
If there’s one thing you need to make sure of, though, it’s that your PC 
is up to date. Windows 7 users must be running Service Pack 1 to 
enable the update, and Windows 8 users must have upgraded to the 
latest version of Windows 8.1. You’ll also need to enable your Windows 
10 reservation. Look for the tiny Windows icon down in the right 
corner of your taskbar, and click it to launch the Windows 10 
reservation app. (We walk you through the reservation process at: 
go.pcworld.com/win10res.)

Here are the system requirements for Windows 10:
Processor: 1 gigahertz (GHz) or faster processor or SoC
RAM: 1 gigabyte (GB) for a 32-bit version, or 2GB for 64-bit
Hard-disk space: 16GB for a 32-bit OS; 20GB for 64-bit OS
Graphics card: DirectX 9 or later with WDDM 1.0 driver
Display: 1024 x 600
Microsoft also warns that even if your PC seemingly meets those 

specifications, it might not be upgraded. “Driver and firmware 
support, application compatibility, and feature support” could affect 
whether the Windows 10 upgrade takes place. Fortunately, there’s 
one way to be sure: use the “check my PC” function within the 
reservation app.

Microsoft advises that the Windows 10 download will be about 3GB 
in size. Installation will take about 20 minutes for newer PCs, and 
possibly more than an hour for older ones. What the reservation 
process does is kick off background loading of some files before 
Windows 10 “unlocks” on July 29. (Some preordered PC games do the 
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same thing.)
Be smart: Make sure all of your important 

files are backed up before beginning the 
upgrade process, either via OneDrive or a local 
external hard drive. By default, your files will 
remain on the hard drive. “Applications, files and settings will migrate 
as part of the upgrade, however some applications or settings may not 
migrate,” Microsoft says, somewhat cryptically.

And yes, it’s completely free, as long as you take advantage of the 
upgrade before July 29, 2016. Microsoft promises that upgrades will be 
free for the “supported lifespan” of the device; that’s the phrase that 
the company hasn’t really explained fully as yet.

What you’ll leave behind by 
migrating to Windows 10
The upgrade process will involve some sacrifices—
but Microsoft is making an effort to make the 
transition as painless as possible.

For one thing, if you own the premium versions of 
Windows 7—Windows 7 Home Premium, Windows 7 
Professional, Windows 7 Ultimate—as well as 
Windows 8 Pro with Media Center or Windows 8.1 
Pro with Media Center…say goodbye to Media 
Center. Microsoft is going to install its own DVD-
playing app into Windows 10 to replace it. Likewise, Windows 7 
desktop gadgets will be uninstalled. And the Windows 7 versions of 
Solitaire, Minesweeper, and Hearts that came with Windows 7 will 
also vanish, to be replaced with new versions of those apps with 
Windows 10.

Microsoft also says that it may erase “some applications that came 
from your OEM.” That seems to imply that some of your PC’s 
bloatware—or prized utilities, depending on your view—could vanish. 

Finally, Microsoft will uninstall, then reinstall, your antivirus 
application. If your subscription is out of date, however, only 

Your beloved 
Minesweeper 
will be 
revamped for 
Windows 10.

Take advantage of 
cloud storage to save 
critical apps and files.
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Microsoft’s own subpar antivirus app, Windows Defender, will be 
installed. Be sure and check this after upgrading.

Some additional assembly required
Keep in mind that older hardware simply won’t include some of the 
hardware conveniences being included inside new Windows 10 
machines. For example, Windows Hello (go.pcworld.com/w10hello), 
which logs you in to your PC by recognizing your face or your 
fingerprint, won’t work with a webcam—you’ll need a new depth 
camera (like a Kinect for Windows or Intel’s RealSense) to enable it, or 
a fingerprint reader. Speech recognition will work best with a high-
fidelity microphone array, no surprise there. And there’s a whole host 
of nitty-gritty specifics that Microsoft has included for Windows 10 
Professional, such as a requirement for BitLocker and Wi-Fi Direct 
Printing.

In general, however, it seems like your pre-Windows 10 checklist will 
be pretty short: Sign up for a “reservation” for Windows 10, back up 
critical files, and keep an eye on your antivirus subscription as the 
transition takes place. Chances are we’ll be upgrading at the same 
time, so you can rest assured that we’re all in it together. 

Windows Hello 
won’t recognize 
your face without 
a specialized 
depth camera.
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A FEW WELLREGARDED flagship 
devices, a focused core 
experience, a vibrant app 
ecosystem, and a belief in the 
quality of its own products: 
Apple lives and breathes these 
things, and has achieved massive 
profitability in the phone space 
as a result. And it’s about the 
only strategy Microsoft has left 
to try.

Soon after purchasing Nokia’s 
device business for $7.2 billion 
last year, Microsoft began to 
dismantle it—first laying off a 
third of the staff, and more 
recently waving goodbye to 
business unit head Stephen Elop 
and other top executives. Now 
it’s writing off (go.pcworld.com/writeoff) another $7.6 billion in 
impairment from the Nokia Devices and Services Business and laying 
off 7,800 employees. These actions tacitly acknowledge two errors: 
First, buying Nokia itself was a colossal mistake. Second, the strategy 
of making mass-market boring phones instead of eye-catching 
flagship phones was failing.

BY MARK HACHMAN

For Microsoft, the only way 
out of its big Windows Phone 
mess is to follow Apple
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But ignore all the enormous numbers flying around, and focus on 
what’s important. The $7.2 billion Microsoft paid for Nokia is the same 
amount the company doled out to shareholders just last quarter, in 
both share repurchases and dividends. Wall Street might be livid, but 
Microsoft’s still got plenty left in the war chest. 

The real question is whether Microsoft’s Windows Phone strategy is 
still viable. And the answer is: yes—although Microsoft is now 
essentially betting the farm on a successful launch of Windows 10 
Mobile this fall. Nadella pledged to bring to market a more “effective” 
portfolio of Windows phones, a strategy of tough love that managed 
to be both practical as well as aspirational.

“We plan to narrow our focus to three customer segments where we 
can make unique contributions and where we can differentiate 
through the combination of our hardware and software,” Nadella 
wrote in an email (go.pcworld.com/nadella)  that the company 
published. “We’ll bring business customers the best management, 
security and productivity experiences they need; value phone buyers 

NEWS

Sure, they were 
gigantic. But no one has 
forgotten the Lumia 
1520 flagship phablet.
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the communications services they want; and 
Windows fans the flagship devices they’ll love.”

A solid business experience, flagship devices, and 
budget phones. Well, two out of three ain’t bad.

Going it alone
It’s not entirely clear what Nadella’s long-term 
strategy is. Optimists will note that Nadella 
explicitly states that he is “committed to our first-
party devices including phones.” Pessimists, like 
analyst Jan Dawson (go.pcworld.com/dawson), 
believe that Microsoft’s strategy of pushing core 
services like Outlook, OneDrive, and more to iOS 
and Android is a hedge that gives Microsoft a graceful way to exit 
from the phone business if need be. 

If Microsoft is going to make a go of the Windows Phone business, 
it will have to go it alone. In June, AdDuplex’s sample of Windows 
Phones found that more than 96 percent of them were 
manufactured by Microsoft. 

Microsoft doesn’t need dozens of budget phones, just older flagships that it can sell 
at a discount.

Windows Phone 
8 manufacturers, 
according to the 
latest AdDuplex 
numbers.

Nokia/Microsoft
96.74%

Other
.58%
Other
.58%

Huawei
.34%Samsung

.74%HTC
1.61%
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“I honestly expected some of this, and it is likely, economically, a 
tough, but necessary choice,” Wes Miller, an analyst with Directions on 
Microsoft, said in an email. “It seems that there hasn’t been a cohesive 
strategy for Lumia Windows Phones to date in terms of branding, 
marquee devices, or device evolution.”

Miller said he sees Lumia’s evolution unfolding like this: Microsoft 
will try to sell business customers on Office 365 and its Enterprise 
Mobility Suite, while Microsoft will abandon the low end of the market 
and focus on premium devices. Microsoft will then encourage budget 
consumers to adopt Skype, Outlook.com, and OneDrive on other 
devices to lure them into the Microsoft ecosystem. 

The Apple model: Do it right, do it yourself
Ideally, Microsoft’s own first-party 
Lumia phones would stand as a 
Surface of sorts for the phone 
market. Nadella has been remarkably 
consistent with its message: He 
wants Microsoft to create new 
categories of devices that others can 
learn from, emulate, and follow into the market. Today, we’re seeing a 
number of well-built two-in-one PCs or ultrabooks that are just a bit 
more rugged than the Surface Pro 3.

But Microsoft’s Surface model also assumes two conditions that the 
Windows Phone market lacks: a coterie of hardware makers trained to 
follow Microsoft’s lead, and a healthy app ecosystem. Microsoft hoped 
to solve the first problem by seeding budget phones in the U.S. and 
abroad, boosting sales and helping to make the case that a viable 
market existed. Its more recent plan (go.pcworld.com/msplan) to 
bring iOS and Android apps to the Windows platform was designed to 
convince software developers that they could make money from 
Windows, too.

Hopefully, Nadella’s memo shows that its budget phone strategy 
was a mistake. Apple devotees can certainly tell you what components 

Ideally, Microsoft’s own 
first-party Lumia phones 
would stand as a Surface of 
sorts for the phone market.





Apple built into the iPhone 6, but even the most ardent Windows 
Phone fanboy would be hard-pressed to differentiate one Lumia 
budget phone from another.

Apple has shown us that a phone maker doesn’t need dozens of 
unremarkable budget phones. Instead, it marks down the price of 
yesterday’s flagship. Neither does it depend upon a number of 
hardware partners eager to flood the market with their own knockoffs. 

Another case for the Surface phone
I would argue that the core experience of a Windows Phone is as 
vibrant as anything Apple makes. But Microsoft needs to develop a 
flagship phone that can embody it. So far, something like the Surface 
phone has been merely a concept (go.pcworld.com/concept)—but 
maybe it truly needs to become a reality.

This fall, Microsoft needs to proudly unveil Windows 10 Mobile and 
show that its new operating system creates the best business phone 
on the market today. It needs to show how the new universal Office 
apps let users edit and even create documents on the road. And if, just 
if, they lose everything except their Windows phone, they can 
replace their Windows PC with a Windows 10 phone running 
Continuum. Those Windows 10 phones should be well-designed, 

It’s a phone! It’s a 
PC! Continuum 
offers something 
else no other 
phone does, and 
Microsoft needs 
to sell this 
feature in a big 
way.
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desirable devices that will attract new customers and deepen the 
ties with Windows faithfuls.

Microsoft has said it will ship new flagship phones in the fall. 
Assuming that work is nearly completed, today’s layoffs could be 
something more akin to game developers’ being let go at the 
completion of a project. Microsoft’s phone business should keep 
moving forward powered by its own momentum. 

The real test will come this fall, when customers evaluate the new 
flagship phones, Windows 10 Mobile, and Microsoft’s new strategy 
for its Lumia line. Only then will Nadella and the rest of his team 
grade Microsoft’s phone business, and determine whether it will 
pass, or fail. 

This fake 
Microsoft 
Surface phone, 
created by 
Nadir Aslam, is 
the flagship 
smartphone we 
want.
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USERS OF MICROSOFT’S original Surface and other Windows RT 
devices won’t have to wait much longer to get some features of 
Windows 10.

As WinBeta (go.pcworld.com/winbeta) notes, Microsoft has updated 
its Windows 10 FAQ (go.pcworld.com/win10FAQ) with a short line 
about what Windows RT users can expect. “If you’re running Windows 
RT, your device won’t upgrade to Windows 10, but we will have an 
update for you around the time of Windows 10 release,” the FAQ says. 
(Note: Microsoft’s popular Surface Pro line runs 
the full-blown version of Windows and will 
receive Windows 10.)

Windows RT was Microsoft’s ill-conceived 
effort to run Windows on ARM, the 
architecture that powers most 
smartphones and tablets. Although 
Windows RT looked similar to Windows 
8, it couldn’t run desktop software 
with the exception of Microsoft’s 
built-in apps and Office suite. The 

Surface, Windows RT tablets 
receiving promised update 
soon (but not Windows 10)
BY JARED NEWMAN
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benefits of Windows RT were minimal, as Intel quickly closed the 
battery efficiency gap with its lightweight Atom processors, and the 
drawbacks of limited functionality and customer confusion were 
significant. PC vendors 
quickly abandoned ship on 
the whole concept.

With Windows 10, 
Microsoft is changing 
course. The only ARM-based 
Windows 10 devices will be 
descendants of Windows 
Phone, with screens 7 
inches or smaller, and these 
devices won’t have a desktop mode. Larger devices will run full 
Windows 10 on x86-based processors, but will offer universal apps 
that run across all screen sizes.

In January, Microsoft said Windows RT devices will get some 
Windows 10 features in a future update, but the company hadn’t 
revealed timing until now. 

The impact on you at home: The update to Microsoft’s FAQ should 
provide some comfort to those who believed in Windows RT, though it 
doesn’t give any sense of what features they’ll actually get. Windows 
10’s big ticket features include the Cortana virtual assistant, the new 
Edge browser, a pop-up desktop Start menu, and a “Continuum” 
feature that seamlessly switches between full-screen and windowed 
apps. Any bets on which of those features land in the updated 
Windows RT? 

NEWSNEWS

With Windows 10, 
Microsoft is changing 
course. The only ARM-
based Windows 10 devices 
will be descendants of 
Windows Phone.
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HOW FAR CAN we push Moore’s Law (go.pcworld.com/moore)? It’s 
starting to become a concerning question as processors push into 
almost infinitesimally small process nodes.

Intel’s 14-nanometer Broadwell chips suffered from lengthy delays, 
stuttering Intel’s vaunted tick-tock manufacturing schedule. TSMC, 
the company that manufactures graphics processors for AMD and 
Nvidia, has been stuck at the 28nm node for years now. Intel plans to 
push into 10nm in 2017, but IBM’s looking beyond that, and just 
revealed the world’s first working 7nm processor—but it took some 
pretty exotic manufacturing to get there.

Creating a working 7nm chip required moving past pure silicon, IBM 
revealed (go.pcworld.com/ibm). IBM—working with GlobalFoundries, 
Samsung, SUNY Polytechnic Institute, and others—carved the 

IBM’s crazy-thin 7nm 
chip will hold 20 billion 
transistors
BY BRAD CHACOS
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transistor channels out of silicon-germanium (SiGe) alloy in order to 
improve electron mobility at such a small scale. Intel has also said 
10nm will be last gasp for pure silicon chips.

IBM and Co. had to turn to cutting-edge lithography techniques to 
etch features onto the chip. The companies utilized extreme 
ultraviolet lithography, which Intel has also been investing heavily in 
for years now. The details behind EUV get complicated, but essentially, 
it’s a beam of light with a far narrower wavelength (read: width) than 
current lithography tools. The benefits of moving to a smaller feature-
etching tool when working on a chip with 7nm components is obvious.

The consortium also managed to stack the chip incredibly tightly, 
with a 30nm transistor pitch, which helped it achieve a nearly 50 
percent surface area reduction over today’s top-end chips.

The 7nm SiGe chips are nowhere near production-ready, but when 
they’re cleared for commercial use around 2017, IBM says they’ll result 
in “at least a 50 percent power/performance improvement for next 

NEWSNEWS

SUNY’s Michael Liehr, 
left, and IBM’s Bala 
Haranand look at a 
wafer of 7nm chipsD

A
R

R
Y

L 
B

A
U

T
IS

TA
/I

B
M

  







generation…systems” on account of all those process improvements. 
Ars Technica (go.pcworld.com/arstech) has a wonderfully detailed 
write-up on the manufacturing process for IBM’s 7nm chips.

But that’s not even the most impressive number. IBM says that when 
the industry embraces 7nm manufacturing techniques, processors will 
be able to be stuffed with an incredible 20 billion transistors. By 
comparison, Intel’s new Broadwell-U processors pack “only” 1.9 billion 
transistors. 
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THE BBC IS getting into the hardware hacking craze with its second 
device in the last 34 years for school-age children. The British 
broadcaster recently unveiled the Micro:bit, a mini-programmable 
computer meant to teach children how to code and develop hardware 
projects.

The device will be given away to every child in Year 7 at schools in 
the United Kingdom—around one million students—beginning in 

BBC reveals Micro:bit,  
a programmable PC  
that fits in your pocket
BY IAN PAUL
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October. Before the end of the year, the device will also be available 
for sale to customers in the U.K. and other points around the globe. 
Presumably that includes the United States.

Unlike other popular boards such as the Raspberry Pi, the Micro:bit is 
not meant to be used as a standalone PC. Instead, it’s a basic board for 
embedded projects such as a gaming device or a remote control. It’s 
also compatible with more advanced micro PCs like the Raspberry Pi 
and Arduino boards for projects that require more processing heft.

The 1.6-inch by 2-inch Micro:bit comes with a 32-bit ARM Cortex M0 
processor, 25 programmable LED lights arranged in a grid, two push 
buttons for user input, an accelerometer and compass, a micro-USB 
connector, and Bluetooth. The device was originally supposed to come 
with a slot for a watch battery, but the final design cut that, opting for 
a battery pack add-on instead that takes two AA batteries. You can 
find complete specs on the BBC’s website (go.pcworld.com/bbcuk).

A new programmable computer wouldn’t be much good without the 
tools to build something with them. To that end, there will be a new 
website to help students with their coding. The website will work on 
PCs or mobile devices, and lets students save and test their code on 
the site. Code can be written in standard languages including 
JavaScript, Python, C++, as well as Blocks (a visual programming 

NEWS

The Micro:bit 
requires an 
add-on battery 
pack to work as 
a standalone 
device
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language) and Microsoft’s Touch Develop (go.pcworld.com/touch). 
Once the code is ready for real-world action, they 
can transfer it to the Micro:bit via Bluetooth or a 
USB connection.

The Micro:bit is a huge collaboration between 
numerous tech companies including ARM, 
element14 (sellers of the Raspberry Pi), Microsoft, 
and Samsung.

Why this matters
A recurring debate in the tech world is whether there’s any sense in 
teaching children to program. Some argue that programming is hard 
and, just as not everyone needs to know how to fix a car, not everyone 
needs to know how to program. But with computers becoming central 
to pretty much everything, there is value in learning some coding 
basics. Most of us remember enough from math class to know you 
have to multiply before you add. Similarly, a familiarity with how code 
works and a coding mentality to problem solving can go a long way in 
a technology-driven world.

Second time at bat
The Micro:bit is the BBC’s second run at sparking the interest of 
students in computing. In 1981, the BBC worked with Acorn 
Computers to produce the BBC Microcomputer System (BBC Micro) 
sold primarily to schools in the U.K. as part of the BBC’s Computer 
Literacy Project. The device was similar in form to a Commodore 64, a 
non-descript beige box with a keyboard that hooked up to a monitor 
or television.

Unlike the previous computer project, the Micro:bit will be 
distributed to individual students thanks to the ever lowering cost of 
components. It will also be 18 times faster at running code, 70 times 
smaller, and 617 times lighter than its predecessor, the BBC says (go.
pcworld.com/bbcnews). 
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AMD’S POLISHING UP SOFTWARE support for its new Fury X and 
Radeon R300 series graphics cards with the release of new WHQL-
certified Catalyst 15.7 drivers. This sweeping update plays nicely with 
Windows 10, adds the clamored-for (and oft-delayed) CrossFire multi-
GPU support for FreeSync monitors (go.pcworld.com/crossfire), and 
extends some of AMD’s formerly exclusive features (like frame rate 
target control) to the full range of older Radeon R200 series graphics 
cards.

AMD Catalyst 15.7 drivers add 
pretty much every feature 
Radeon gamers begged for
BY BRAD CHACOS
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The Windows 10 support is no surprise, given that Microsoft’s next-
gen operating system launches as we go to press. Nvidia also recently 
pushed out Windows 10-compatible WHQL-certified drivers for its 
GeForce graphics cards. DirectX 12 cometh (go.pcworld.com/directx)! 
But beyond that, Catalyst 15.7’s new offerings should have Radeon 
gamers shouting “Hallelujah!” from the rooftops.

THE STORY BEHIND THE STORY: AMD is often criticized for failing  
to release new WHQL-certified drivers at the same blistering pace  
as Nvidia. That said, the abundance of new goodies enabled in  
Catalyst 15.7 proves that AMD can stay feature-competitive with  
the GeForce gang, even if those features are released at a slightly 
slower pace—and they’re sure to bring a smile to the faces of  
Radeon gamers everywhere.

What’s new in AMD’s Catalyst 15.7 drivers
The first of many improvements in the drivers is FreeSync support for 
CrossFire setups. AMD’s FreeSync (and Nvidia’s competing G-Sync) 
force your monitor and your graphics card to synchronize their refresh 
rates—hence the name—to provide a silky-smooth gaming experience 
free of screen-tearing and stuttering. Simply put, they rock.

NEWSNEWS
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The first FreeSync monitors rolled out in March, but without support 
for multi-GPU CrossFire setups. That was kind of a bummer: FreeSync 
rocks, but buying a FreeSync-compatible monitor essentially locks you 
into using Radeon-brand graphics cards for five to ten years. That 
makes it most appealing to AMD’s Team Red diehards—aka, the very 
people most likely to be running a multi-GPU CrossFire setup. AMD 
had to cancel its initial plans to release CrossFire FreeSync support in 
April, stating “it’s now clear to us that support for AMD FreeSync 
monitors on a multi-GPU system is not quite ready for release”—but 
now it is. Hallelujah! (AMD dual-GPU configurations that pair an APU 
with a single discrete graphics card aren’t supported, however.)

More importantly for gamers with more modest setups, Catalyst 15.7 
extends support for AMD’s nifty Virtual Super Resolution and Frame 
Rate Target Control technologies to a wider range of older hardware.

Virtual Super Resolution debuted with AMD’s feature-stuffed 
Catalyst Omega drivers last December, but it worked only with a 
handful of high-end graphics cards (the R9 285, R9 290, R9 290X, and 
dual-GPU R9 295X2), ostensibly due to the need for internal hardware 
scalers. Well, somebody at AMD must have figured out some software 
trickery, because VSR is now supported on those GPUs, the full range 
of new Radeon R300 series graphics cards, and all Radeon R7 260 and 

Targer Display Timing Supported VSR Modes

1366 x 768 @ 60Hz 1600 x 900
1920 x 1080

1600 x 900 @ 60Hz 1920 x 1080

1920 x 1080 @ 60Hz 2560 x 1440
3200 x 1800
3840 x 2160 (R9 285, 380, and Fury X)

1920 x 1200 @ 60Hz 2048 x 1536
2560 x 1600
3840 x 2400 (R9 285, 380, and Fury X)

2560 x 1440 @ 60Hz 3200 x 1800

1920 x 1080 @ 120Hz 1920 x 1200 @120Hz, 2048 x 1536 @ 120Hz
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above GPUs, along with all A-series 7400K and above desktop GPUs. 
(Hallelujah!)

Virtual Super Resolution forces your graphics card to render games 
at a higher resolution than your monitor natively supports, then 
downsamples the image to your display’s native resolution when it’s 
sent to your monitor. Doing so enables a far wider field of view in 
games and provides smoother edges on images—functioning kinda-
sorta like anti-aliasing. Virtual resolutions up to a full 4K are supported, 
if your hardware and monitor both support it.

Frame Rate Target Control, on the other hand, appeared in the 
launch drivers for the Radeon R300 series graphics cards in June. This 
technology essentially lets you set a hard cap on your frame rates in 
games, which—as our extensive testing proved (go.pcworld.com/
control)—can provide tangible, large benefits for both power and 
heat use when it’s enabled with titles that push a tremendous amount 
of frame anyway.

NEWS

Power savings 
provided by enabling 
FRTC at various cap 
levels in BioShock: 
Infinite.
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MEASURED IN MIN/MAX WATTAGE; LOWER IS BETTER

BIOSHOCK INFINITE: 
MAX POWER FRTC  75 FPS

BIOSHOCK INFINITE: 
MIN POWER FRTC  75 FPS

BIOSHOCK INFINITE: 
MAXPOWER FRTC  55 FPS

BIOSHOCK INFINITE: 
MIN POWER FRTC  55 FPS

BIOSHOCK INFINITE:  
MIN POWER FRTC OFF

BIOSHOCK INFINITE:  
MAX POWER FRTC OFF

0 100 200 300 400

 SAPPHIRE RADEON TRIX 390X  AMD RADEON FURY X

347

281

291

231

285

249

248

209

424

381

344

301





The fact that the feature was originally limited to new R300-series 
cards irked some Radeon faithful, as the GPUs at the heart of the new 
graphics cards are essentially retooled versions of the graphics 
processors that also powered the older R200 series. AMD’s setting 
things right now, however, by extending support for FRTC to all 
Radeon R7 260 and above GPUs—just like with VSR. 
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How many light bulbs
        does it take

to change an American?

It’s no joke: climate change is a critical issue for all life 
on Earth. But can the actions of one individual really 
make a difference? Visit nature.org to calculate your 
impact on the world around you and learn about steps 
you can take to make the world a better place for us all.

nature.org/calculate

Photo © istockphoto.com / Color of Time
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FRESH FROM ITS defeat in women’s World Cup soccer, Japan wants to 
take on the United States once again—in giant robot combat.

Suidobashi Heavy Industry has agreed to a challenge from Boston-
based MegaBots that would involve titanic armored robots developed 
by each startup.

While robot combat contests such as RoboGames are nothing new, 

Giant mechs from  
Japan, U.S. will meet  
in epic robot battle
BY TIM HORNYAK
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the duel is being billed as the first of its kind involving piloted 
machines that are roughly 4 meters tall.

Unveiled in 2012, Suidobashi’s Kuratas robot was designed by 
blacksmith Kogoro Kurata, who was inspired by the “mecha” robots of 
Japanese science fiction animation.

Weighing some 5,000 kilograms, Kuratas has three wheels, two arms, 
a one-person cockpit and various mock weapons that shoot pellets 
and fireworks. It was put on sale on Amazon Japan as a starter kit for 
¥120 million ($976,000) but is now listed as unavailable.

“We can’t let another country win this,” Kurata, who is CEO of 
Suidobashi, said in a video posted to YouTube (go.pcworld.com/
kuratas). “Giant robots are Japanese culture.”

Suidobashi did not immediately respond to a request for more 
information.

The contest, which would take place next June, set the hearts of 
robot geeks aflutter after the challenge was issued in an over-the-top 
video (go.pcworld.com/megabots) by MegaBots that has notched 
more than 2 million views.

MegaBots’ Mark II robot weighs some 5,400 kg, is piloted by a team 

NEWS

MegaBots’ 
Mark II robot.
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of two, and moves around on 
tank-like tracks. Its cannons 
can fire 1.3-kg paint balls at 
161 kilometers per hour. The 
company wants to build 
enough robots to form 
teams that would fight in 
arenas, but its 2014 
Kickstarter campaign (go.
pcworld.com/kickstarter) 
failed to reach its goal of 
$1.8 million.

Kurata said he wants the 
robots to be able to engage 
in a full-on knock-down fight 
to make the duel interesting.

Indeed, living up to 
audience expectations could 
be the most challenging 
aspect of the fight. Kuratas 
and MegaBots Mark II are 
very costly to make and carry 
human pilots, so allowing 
them to be destroyed or 
seriously damaged in battle would likely be out of the question.

But the spectacle would be better than other robot clashes, and 
could even form the basis for an annual piloted robot championship. 
As viewers of the recent DARPA Robotics Challenge finals (go.pcworld.
com/darpa1) saw, contests involving autonomous robots can be 
painfully slow. Even the matches at RoboCup (go.pcworld.com/
robocup), an international competition aimed at developing fleet-
footed, dextrous robots that can beat the best human soccer players, 
can move at a glacial pace as droids clumsily try to dribble the ball, 
kick it, and then topple over. 

Suidobashi 
Heavy 
Industry’s 
Kurata.



The Safeway Foundation and the Entertainment Industry Foundation are 501(c)(3) tax-exempt organizations. Photo by: Nigel Parry

The Hunger Is campaign is a collaboration between The  
Safeway Foundation and the Entertainment Industry Foundation  
to raise awareness and improve the health of hungry children.



AFTER YEARS OF sorting news feeds primarily by algorithm, 
Facebook is letting users choose what they want to see 
first. An update (go.pcworld.com/fbapp) to Facebook’s 
iOS app expands the existing News Feed Preferences 

section with a way to choose whose updates appear at the top of 

CONSUMER 
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Make smart purchases,  
stay safe online.

Sometimes humans are better 
than machines at figuring out 
what they want. Who knew?
BY JARED NEWMAN

Facebook 
lets you 
avoid the 
algorithm 
and control 
your own 
news feed
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the timeline. A similar update is coming to Facebook’s 
Android app and desktop website in the coming weeks.

Users can check out the new settings by pressing the 
More button in the Facebook app’s bottom right corner, 
then tapping on News Feed Preferences and selecting 
Prioritize Who To See First. This brings up a list of friends 
and Pages that users can mark as favorites. Unread 
updates from favorite contacts will always appear at the 
top of the News Feed, overriding 
Facebook’s predictive algorithms.

This preferences menu also lets users 
“unfollow” certain contacts, which simply 
hides their updates without severing the 
friendship. Other options include a way 
to discover new Pages based on ones 
that users have liked in the past, and a 
Reconnect menu that shows a list of 
unfollowed friends.

Why this matters
Until now, Facebook has relied 
extensively on its own algorithms to 
decide what users see, drawing on their 
histories of likes, comments, and other 
interactions. But machine learning 
doesn’t always work perfectly, and can 
leave people with News Feeds that they’re less likely to 
interact with in the first place. Users have always wanted 
ways around the algorithm—just look at the number of 
people trying to sort their feeds chronologically (go.
pcworld.com/sort)—and the new preferences are one 
way to add greater flexibility. 


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GOOGLE’S REFUSAL TO implement the EU’s controversial right-to-be-
forgotten rules in the United States amounts to an unfair and deceptive 
business practice, a frequent critic of the search engine giant said.

Consumer Watchdog (consumerwatchdog.org) filed a complaint 
against Google with the U.S. Federal Trade Commission, said John 
Simpson, director of the group’s Privacy Project. The complaint (go.
pcworld.com/complaint) asked the FTC to rule that Google, by 
declining to delete search engine links on request from U.S. residents, 

BY GRANT GROSS

Privacy group file FTC  
complaint against Google

CONSUMER 
WATCH





is an unfair business practice that violates the U.S. 
FTC Act (go.pcworld.com/usftc).

Arguing that the right to be forgotten is 
an “important privacy option,” Consumer 
Watchdog’s complaint stated that 
although Google claims to be concerned 
about users’ privacy, it doesn’t offer 
people in the United States “the ability to 
make such a basic request.”

“Describing yourself as championing users’ 
privacy and not offering a key privacy tool—
indeed one offered all across Europe—is 
deceptive behavior,” the document reads.

Unfair business practices are defined in 
the FTC Act as those that cause substantial 
injury to consumers that they cannot 
reasonably avoid themselves and that are 
not outweighed by other benefits.

Before the Internet, it was difficult to 
track down records of the foolish things 
people did when they were young, Simpson said.

“This reality that our youthful indiscretions and embarrassments and 
other matters no longer relevant slipped from the general public’s 
consciousness is privacy by obscurity,” he said by email. “The Digital Age 
has ended that. Everything—all our digital footprints—are instantly 
available with a few clicks on a computer or taps on a mobile device.”

A Google representative didn’t respond to a request for comment 
on bringing the right to be forgotten to the United States.

Since launching as the Inside Google Project in late 2008, Consumer 
Watchdog’s Privacy Project has largely targeted Google, while paying 
significantly less attention to the privacy practices of several other 
Internet companies. Google representatives have questioned the 
impartiality of the group.

Under the European Union’s right-to-be-forgotten rules, residents of 

Consumer Watchdog’s 
complaint to the FTC 
argues that the right to be 
forgotten is an “important 
privacy option.”
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EU countries can ask search engines to delete links to information about 
them they find objectionable. The ruling, which went into effect in May 
2014, does not require the information be deleted from the Internet, 
only that search engines not link to it.

The European Union’s rule has been 
controversial, with some critics saying 
it amounts to censorship. “As a simple 
test, ask yourself whether this would 
be possible in the United States 
without a repeal or modification of the 
First Amendment—it would not,” Wikipedia founder Jimmy Wales 
said last year.

Google, the largest search engine, has granted about 41 percent of 
the right-to-be-forgotten requests it has received in Europe. In several 
cases, Google has declined to remove links to news stories about 
criminal activity.

Google has managed right-to-be-forgotten requests in Europe in a 
way that is not “burdensome” to the company, Consumer Watchdog 
said. Since the European Union implemented the right-to-be-
forgotten rule, Google has received about 1 million requests to 
remove links from its search engine.

Google’s cost of reviewing requests should be part of its “reasonable 
cost of doing business as a search engine,” Simpson said. The rule 
should apply in the United States not only to Google, but to other 
search engines as well, he added.

Consumer Watchdog has focused on Google because it is “so 
dominant as a search engine,” Simpson said.

Consumer Watchdog is not attempting to bring strong EU privacy 
laws to the United States, Simpson added. But real people are being 
“hurt” by Google’s failure to honor U.S. requests, he said.

“We’re not arguing that European laws should apply in the U.S.,” he 
said. “We’re saying that aggressively marketing yourself as being 
concerned about consumers’ privacy, but not offering a key privacy 
tool is deceptive.” 

CONSUMER 
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WITH THE ARRIVAL of El Capitan (go.pcworld.com/elcapitan2) on 
Google Street View recently, you can now haul yourself virtually up 
one of the most famous rock faces in the world. Navigating certain 
streets in urban areas, however, can still be a challenge.

As Google expands Street View into ever more exotic places, it 
appears to have a problem in many of the towns and cities where the 
service has been available for years. Look closely at any major city, 

BY ZACH MINERS

The vanishing: What 
happened to Google Street 
View’s missing streets? 
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especially the residential areas, and Street View is littered with 
hundreds, even thousands, of little gaps. And although it’s hard to be 
sure, the problem may be getting worse.

Street View is still a powerful tool and the gaps don’t greatly diminish 
its utility—unless they happen to be in front of the building you’re 
searching for. But it’s strange that even in cities that Google’s cars have 
photographed several times over, there are still numerous stretches—
sometimes whole streets—where Street View imagery isn’t available.

A bug, not a feature
Google called the gaps a “known issue” and implied it’s due partly to a 
glitch in its early mapping software. But it refused to answer questions 
beyond that, including whether privacy requests are a factor, and 
whether the gaps are becoming more frequent.

“In places where we collected very early Street View imagery, the old 
data may sometimes cause an issue that prevents new images from 
surfacing,” the company said via email. “We’ve so far prioritized refresh 
of the bulk of the Street View imagery for our users, and we are 
certainly also working to fill these occasional gaps.”

The Barnsbury 
area of north 
London, where 
there are gaps in 
Street View, 
pictured July 2, 
2015.
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There are two types of gaps, broadly speaking. One is where a building 
has been blurred, which poses little problem for Street View explorers 
and is almost certainly due to a privacy request. Harder to fathom is 
where sections of streets are missing, 
signified by gaps in the blue lines that 
appear when you click on the yellow 
Street View icon in Google Maps.

There could be many reasons for the 
gaps, as Google has discussed in the 
past. In some cases, construction work 
may have prevented its mapping car 
from passing through. A wide swathe of Hunters Point (go.pcworld.
com/hunterspoint) in San Francisco is missing, for example, but the 
images of adjacent streets show a lot of construction was going on. In 
other cases, a Street View driver might have skipped a street by 
accident, or the camera or recording software might have 
malfunctioned.

Why wasn’t this caught in subsequent visits?
But Google often revisits towns to update its imagery, and it’s hard to 
see why the Sunset residential district in San Francisco, for 
example—more or less in Google’s backyard—would have so many 
gaps (go.pcworld.com/gaps). The pattern is similar in Tokyo, London, 
Berlin, and many other cities around the world. The gaps aren’t big, 
and it’s possible to overlook them at first glance, but once you’re 
aware they exist, they seem to appear all over the place.

One possible culprit is that people have asked to have their homes 
blurred for privacy reasons. Google explains on its Maps privacy page 
(go.pcworld.com/viewprivacy) how to request this, and it’s a 
relatively simple process.

Famous people often file such requests. There’s a gap in the Street 
View imagery outside Mark Zuckerberg’s house in Palo Alto, for 
instance, although his home was visible in the past. But a lot of 
regular folk have asked to have their homes removed too, judging by 

One possible culprit is 
that people have asked to 
have their homes blurred 
for privacy reasons. 
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the prevalence of blurred images in residential areas.
In some cases, those blurring requests may have caused some of 

the gaps in Street View. If you approach the edge of a gap on a 
residential street, you can often zoom in and see a house in the 
missing section that’s been blurred out. It’s hard to be sure about the 
causes, though, since Google isn’t talking.

Nein, says Germany
In extreme cases, whole countries are affected. Privacy has been a 
particular issue in Germany, where many people objected to the roll-
out of Street View. Google now has Street View images only for big 
cities in Germany, like Berlin and Frankfurt, and appears to have given 
up on the rest of the country completely. Zoom out over Europe in 
Street View mode and Germany is mostly a blank island in (go.
pcworld.com/blankisland) a sea of blue.

Some users have noted the gaps in a Google Maps forum (go.
pcworld.com/mapforum), and they point to some strange examples. 
On the tiny island of San Andres in the Caribbean Sea, a Street View 
car appears to have driven a third of the way around the island’s 
perimeter road and then stopped for no obvious reason. There are no 

Google has 
blurred out 
the home of 
Sheryl 
Sandberg, 
Facebook’s 
chief operating 
officer.
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apparent obstacles or construction—though there does happen to be 
a bar by the side of the road where the car stopped capturing images.

There’s another curiosity in San Francisco’s Presidio Terrace, (go.
pcworld.com/presidio) a gated community with a circular road and 
about two dozen homes. Most of it doesn’t appear on Street View, but 
there are a few short stretches deep inside the complex that do. A 
telltale shadow shows that one of Google’s cars was in there, but for 
some reason Google displays images for only a fraction of it.

Other reasons for gaps in Street View could include temporary lane 
closures, the construction of new roads since Google photographed an 
area, and safety issues that prevented drivers visiting certain streets, 
said Jon Froehlich, an assistant professor of computer science at the 
University of Maryland, College Park, who has used Street View imagery 
to study accessibility problems (go.pcworld.com/accessibility).

Plenty of exotic locales are impressively covered, however, and 
Google is adding more all the time. If you want to use Street View to 
check out the Great Barrier Reef (go.pcworld.com/reef)—where the 
fish apparently have no concerns about privacy—you can really go 
to town.  

This is the 
southernmost 
coral cay of the 
Great Barrier 
Reef. 
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TMOBILE ANNOUNCED that there would be no added charges for its 
U.S.-based Simple Choice customers when they call, text, or use data 
to Mexico and Canada or when traveling there.

The move makes T-Mobile the first carrier to offer continental 
phone service under a single plan anywhere in the world, company 
officials said.

BY MATT HAMBLEN

T-Mobile says customers 
can roam in Canada,  
Mexico for free





The new Mobile without Borders plan means that customers can call 
from the United States to both countries for no added cost, as well as 
make calls from those countries when they travel in either one.

Both consumers and business customers will be eligible, although 
business customers will pay $1 more per phone line for accounts with 
more than 10 phone lines, with no added cost for the first 10 lines.

T-Mobile CEO John Legere said the impact on business customers 
will be especially pronounced. About 70 percent of travel by small and 
medium-size businesses is to both countries, T-Mobile said, citing data 
from the travel industry. Also, 35 percent of all international calls 
across the phone industry were from the United States to the two 
countries last year.

Spiting Donald Trump
During a conference call (go.pcworld.com/conference) to announce 
the new plan, Legere blasted GOP presidential contender Donald 
Trump for his comments on wanting to build a wall on the U.S. 
border with Mexico, at a time when joint trade opportunities are 
expanding and the need for affordable communication and 
interactions is expanding. The new Mobile without Borders phone 
plan offers an alternative to the proposed wall, he contended, while 
jabbing at Trump.

“Donald Trump wants to put a wall up, but our phone coverage will 
work seamlessly” between the two countries, Legere said. “Don’t 
worry about the wall.” He quickly added: “Sorry, Donald, for hurting 
your major platform for running for president. Donald Trump is the 
gift that keeps on giving…He really is entertaining.”

Legere saved his biggest condemnation for AT&T CEO Randall 
Stephenson, for recently buying two Mexican wireless carriers for $4 
billion to be able to offer AT&T phone services there as well as in the 
United States. “Sorry, Randall, you are not the only and first” provider 
for Mexico and the United States, Legere said.

CONSUMER 
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Reciprocal roaming
Legere said it wasn’t necessary for T-Mobile to operate its own 
network in Canada and Mexico and will rely instead on the two largest 
carriers in each country to supply service. T-Mobile was able to forge 
reciprocal roaming deals with the four foreign carriers, which he 
didn’t name, to lower traditional costs. In Mexico, Telcel, with 70 
million customers, and Movistar, with 
20 million, are the two largest carriers, 
according to recent industry data. In 
Canada, Rogers is the largest, with 9 
million customers, while Telus and Bell 
are nearly tied, with 8 million apiece.

Those T-Mobile partners have plenty 
of 4G LTE service in major cities that 
offer fast data services, Legere said. 
Even though T-Mobile has expanded 
LTE coverage in the United States, critics often ding the carrier for 
having weak or spotty coverage outside of major U.S. cities. Analysts 
said it remains to be seen how thorough the coverage is in Canada 
and Mexico.

International appeal
Even with such concerns, analysts said the new plan will appeal to 
travelers, both consumer and business.

“T-Mobile is stealing the industry’s—and especially AT&T’s 
thunder—by expanding the free calling area to Mexico and Canada,” 
said Roger Entner, an analyst at Recon Analytics. “The new plan is 
most appealing to people who, no surprise, call and travel to Mexico 
and Canada the most.”

T-Mobile posted details on Mobile without Borders for consumers 
(go.pcworld.com/consumer) as well as for business customers (go.
pcworld.com/bconsumer) on its website.

For business customers using Mobile without Borders, T-Mobile 

T-Mobile was able to 
forge reciprocal roaming 
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adapted its Un-carrier for Business (go.pcworld.com/uncarrier) plans 
announced in March.

Business plans affected, too
Under the March announcement, the first 20 business lines would 
cost $16 a line (or $15 a line for 21 lines or more) per month, which 
includes voice and text and 1GB of data. With the Mobile without 
Borders plan, the first 10 business lines cost nothing extra, but there 
is a $1 added cost per phone line for 11 or more lines, T-Mobile 
officials said.

With the Mobile without Borders plan, 50 percent of the calls, texts, 
and data used every three months must be done from inside the 
United States. That restriction keeps the plan devoted to U.S.-based 
customers, T-Mobile said.

The March business plan was immediately so successful that it 
produced a 120 percent increase in traffic flow into 3,000 T-Mobile 
stores, Legere said. T-Mobile might provide more details on the 
bottom-line impact of its business plans when it announces earnings 
on July 30, he hinted.

“Overall, we’ve been astounded” by the interest from businesses, 
said Rakesh Mahajan, senior director of marketing for @Work at 
T-Mobile. Some customers have said they didn’t realize T-Mobile was 
in the market for business customers.

Mahajan said Mobile without Borders could be expanded beyond 
Mexico and Canada to other countries. “We started with the biggest 
opportunity and customers will figure out where we go next,” he said. 
Legere and other officials didn’t commit to offering such a plan in 
Europe, when asked.

Mexico, in particular, has been an attractive market because trade 
barriers have been lowered in recent years, meaning more U.S. 
businesses are working with manufacturing partners in Mexico,  
he said. 
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Hard-core hardware: We 
stuffed this PC with 128GB 
of cutting-edge DDR4 RAM
The 64GB barrier in system memory is now broken by DDR4 RAM in 
Intel’s Haswell-E. Watch us tear down that wall.
BY GORDON MAH UNG

TESTED IN PCWORLD LABS 
In this section, hardware & software 
go through rigorous testing.
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HUMANS LIKE TO CELEBRATE BARRIERS being broken. 
The speed of sound. The first 1GHz processor, or 1TB 
hard drive.

So get ready to pop the California sparkling wine, 
because we just smashed right through the 64GB system RAM barrier.

That barrier, if you didn’t know, has vexed consumer computing for 
years now. Mainstream desktop PCs have all featured four slots for a 
maximum of 32GB of DDR3 RAM. At the high end, prosumer PCs 
doubled that to eight slots for a maximum of 64GB DDR3. 

With the move last year to DDR4 RAM in Intel’s Haswell-E, we were 
promised we’d finally break the 64GB mark. That time has come.

Both Corsair and Kingston recently announced 128GB memory kits 
using 16GB DDR4 memory modules. We had to try one out. 

What made this possible
If you’re wondering why we’ve been locked in at 64GB for so long, it’s 
mostly due to the technology and process changes. DDR3 modules 
topped out at 8GB, in what’s typically called an unbuffered DIMM. You 

Watch the 
video at

go.pcworld.
com/ 

128gbramvid
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could actually get higher-capacity modules in DDR3, but they were only 
in registered or buffered DIMM. These memory modules are meant for 
servers or workstations, which typically cost an arm and a leg and run at 
much slower speeds, because they sacrifice density for reliability.

The move to DDR4 last year with Intel’s Haswell-E CPU also promised 
higher-density chips. While DDR3 maxed out at 8GB, DDR4 now maxes 
out at 16GB per module. 

Corsair Dominator Platinum 
To break the barrier, we reached out to Corsair for its 128GB kit (go.
pcworld.com/corsair128gbram). The company actually has three 
speeds: DDR4/2800, DDR4/2666 and DDR4/2400 at the Platinum 
level. The kit we used was the DDR4/2400, and it comprises eight 
16GB modules. It comes in a matched set with two heat-sink fans. The 
module’s not cheap: The fastest DDR4/2800 set is $2,120, while the 
two lower-speed kits are $1,980. In true computer tradition, though, 
prices have already begun to fall. Corsair has since released its 
Vengeance LPX line at the same density and speed for $1,600.

Here’s what 
128GB of DDR4 
looks like.
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What you need
Not everyone can get to 128GB of RAM. Obviously, you need eight 
memory slots. You’ll also need a CPU that supports DDR4, but you 
don’t need a $1,000 Xeon or Core i7-5960X CPU. For this particular 
test I used Intel’s cheapest Haswell-E CPU, a Core i7-5820K. The final 
ingredient that you’ll need is a motherboard whose BIOS supports 
128GB of RAM.

When I first plugged the 128GB of RAM into our Asus X99 Deluxe/
U3.1 board and threw the switch, it wouldn’t boot. Only after 
obtaining a beta BIOS from Asus would the board POST. The good 
news is, I’m told by Asus that it expects to roll out support across its 
X99 board lineup as we speak. I expect other motherboards to support 
128GB of RAM, too, as the modules become more common.

Once I updated the board to the latest BIOS, all went as expected 
without any hitches. The OS I used on our PC was Windows 8.1 
Enterprise. If you still don’t believe I got the bottom-feeder Core 
i7-5820K to work with 128GB of RAM, here’s proof.

One of the first 
128GB DDR4 kits 
out is Corsair’s 
Dominator 
Platinum that’ll 
set you back 
$1,980.
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Uhh, now what?
I’ll admit, I was giddy firing up a PC with 128GB of RAM in it, but once I 
was booted I experienced a “now what” moment of doubt. Few people 
need more than 16GB of RAM, and some can even get by with 8. 
Outside of the 1-percenters who may need 64GB of RAM for extreme 
Photoshop, virtualization, or multitasking, it’s just not needed. 

To make use of this glorious amount of hardware, I settled on 
creating one massive RAM disk. RAM disks use your system’s RAM to 

We needed a 
beta BIOS for 
the Asus X99 
Deluxe U3.1 to 
get the 128GB 
of RAM work-
ing in our  
system.
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simulate a storage “disk.” They’ve been around for years but typically 
are far smaller due to the constraints of memory. Not everyone needs 
a RAM disk, but if you need access to temporary storage that puts 
even the most powerful SSDs to shame, a RAM disk is the way to do it.

I fired up Softperfect RAM disk and dialed in a 100GB RAM disk. 
Here’s what’s so great about the RAM I had: Even with a 100GB RAM 
disk, I had 28GB or so of memory left to work with.

To find out just how fast this RAM disk could be, I ran Crystal Disk 
Mark. As you can see, the performance puts any SSD to shame. The 
mighty Intel 750-series SSD, for example, has a sequential read speed 
of maybe 2.7GBps. The RAM disk was hitting 8.7GBps.

RAM disks have one pretty big downside: if there’s a sudden power 
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outage or serious BSOD, kiss 
goodbye anything you had in the 
RAM disk that wasn’t previously 
saved. It’s gone baby, gone.

It’s obvious I’m reaching for use 
cases for this much RAM, but there 
are people out there who 
legitimately need this capacity. It’s 
just not for 99 percent of us. What 
this really is about, though, is finally 
breaking through the 64GB barrier. 

Yes, 128GB of system RAM seems 
silly, but if you dial back the clock, 
people used to say that about 
16MB of RAM and 1GB of RAM. One 
day, I can say with confidence, we’ll look back and laugh at how silly we 
were to be in awe of 128GB of RAM—when we’re all running 1TB and 
counting. 




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Lenovo Yoga 
Tablet 2 Anypen  
(8-inch): Yes, you  
can write on it with a fork
BY JON L. JACOBI

WHEN LAST I COMMUNED with a Windows-powered Lenovo Yoga 
Tablet 2 (the 10-inch version), the event was soured by the worst 
auxiliary keyboard I’ve ever experienced. Thankfully, Lenovo didn’t see 
fit to saddle the Windows version of the smaller $300, 8-inch Yoga 
Tablet 2 Anypen (go.pcworld.com/yogatablet2anypen) with 
something similarly irritating. The Yoga Anypen is a neat little tablet 
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with an innovative design and versatile digitizer, though not 
necessarily a platform for serious business use.

What ‘Anypen’ means
The headline feature of the Yoga Tablet 2 Anypen is its advanced 
digitizer. You can use a pencil, ballpoint pen, or just about anything with 
a metal tip 1mm or larger. Most digitizers require a capacitive stylus with 
at least a 5mm tip. You might want to avoid X-Acto knives, but other 
than that you’re good to go. You may, of course, also use your fingers.

Another unique aspect of the Yoga Tablet 2 design is the cylinder 
running along one edge that allows for a far larger battery than a 
normal, flat tablet can accommodate. The battery tube also allows a 
grip that uses all your fingers, yet doesn’t place your thumb near the 
display. Many is the time I’ve accidentally flipped pages on an iPad mini.

The Yoga Tablet 2 (both sizes) has a distinctive kickstand that jackets 
the battery tube. It clicks into place at about 42-, 85-, and 180-degree 
angles, but you can manage angles in between due to the large 
amount of friction. Even more unique is the hole in the kickstand 
for hanging the Yoga Tablet 2 on a wall, for 
storage or an ad-hoc cinematic 
experience.

Beyond that, the Yoga 
Tablet 2 Anypen (with 
Windows) is, well, a 
smallish 
Windows 
tablet 
running 
Windows 8.1. 
Its outstanding 
feature in that 
regard is the free year 
of Office 365.

Hardware-wise, you’re 

The cylinder at its base lets you  
grip the tablet and also lets  

Lenovo put in a massive  
6,400mAh battery.





talking a Bay Trail Atom Z3745 CPU, 2GB of DDR3/1066 system 
memory, an 8-inch 1,920 x 1,200 touchscreen display, and a 32GB 
eMMC SSD—generally nice specs, but not a lot of disk space for 
running Windows. Indeed, with only 19.7GB of free disk space before 
we installed anything, we were unable to use our 20GB data sets for 
read/write testing.

Performance and run time
In my hands-on, the Yoga Tablet 2 Anypen seemed lively enough, but 
the numbers are strictly Atom: PC Mark 8 rated the tablet at 1,375 in 
the work test and 897 in the creative test. 3D Mark didn’t measure 
playable frame rates until it got to Ice Storm Extreme, a Web graphics 
game where the Tablet 2 Anypen scored 7,967. While that’s quite nice 
compared to last-generation Atoms, it’s not Core-like. Overall perfor-
mance, in fact, is pretty much identical to the 10-inch version’s (go.
pcworld.com/yogatablet2). In fact, you could look at the 10-inch Yoga 
Tablet 2 results from our Surface 3 review (go.pcworld.com/surfa-
ce3review) and pretend it’s the 8-inch version and not miss a beat.

Regardless, there were no frustrating waits thanks to the Samsung 

The Yoga 2’s per-
formance easily 
eclipses the older 
Atom used in the 
S12 Netbook, but 
the newer Surface 
3’s Cherry Trail 
Atom clearly stays 
ahead.
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MBG4GC SSD, which scored 168MBps reading and 75MBps writing 4MB 
files under CrystalDiskMark. That’s quite good for an eMMC-based SSD.

Battery life was 6 hours and 58 minutes, and that’s measuring with 
PCMark’s battery rundown test, which works uninterrupted. Unless you 
drink a lot more coffee than I do, you can add a few hours to that figure.

Multimedia and connectivity
The Yoga Tablet 2 Anypen rendered 1080p movies quite nicely, and the 
sound is adequate. There’s plenty of volume, enough to create 
distortion if you crank it up all the way. The stereo separation is also 
better than average, due to the placement of the speakers on either 
end of the battery tube. The microSD card slot on the back can expand 
storage if you want to keep a decent collection of movies on board.

The only ports on the Tablet 2 Anypen are the headset jack and the 
micro-USB port, which can be used for temporary storage as well as 
charging the unit, or conversely, charging other devices. Having that 
large battery on board is handy. The Wi-Fi is 802.11 a/b/g/n, and 
there’s Bluetooth for connecting peripherals. Alas, there’s no WiDi or 

Forgot your 
digital stylus? No 
problem. Use your 
pen instead with 
the Yoga Tablet 2 
Anypen.





even MHL support via the microUSB, so with the lack of video ports, 
you really are stuck with the 8-inch display. 

As with any tablet worthy of the name, there are cameras: an 
8-megapixel back-facing one for snapping photos, and a 
1.6-megapixel front-facing one for Skyping and the like.

The 8- or 10-inch dilemma: Size vs. weight
When it comes to mobile computing 
of the business kind, I generally 
recommend larger displays and 
keyboards. My theory is that usage 
far exceeds tote time, so go for the 
best computing experience. How-
ever, when it comes to tablets, 
smaller means lighter (the Anypen 
weighs a measly 0.94 pounds) and 
easier to hold.

As the Yoga Tablet 2 also comes in Android flavors, though without 
the Anypen digitizer, the display-size (8- or 10-inch) buying decision is 
complicated. The 8-inch version is better as a tablet, but should you 
then be opting for Windows? For real work, the screen items and text 
are small even when you magnify to 150 percent. I had to skip all the 
way to 200 percent (a custom setting) before my admittedly bad 
vision was comfortable using Windows. At that point, the extra pixels 
are basically wasted.

Conclusion
The 8-inch Yoga Tablet 2 Anypen (with Windows) is a nicely realized 
tablet with long run time that lets you use just about anything as a 
stylus (I used a fork once). It’s good for tablet tasks, and the occasional 
light business chore, by all means.

For extensive business usage, opt for the 10-inch Yoga Tablet 2 but 
forgo Lenovo’s misbegotten BC800 keyboard. Or, if I’m really going to 
be honest, buy an 11- to 13-inch laptop. 

As the Yoga Tablet 2 also 
comes in Android flavors, 
though without the Anypen 
digitizer, the display-size  
(8- or 10-inch) buying 
decision is complicated. 
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M-Disc optical media 
reviewed: Your data, good 
for a thousand years
BY JON L. JACOBI

YOU’RE DONE WITH OPTICAL DISCS 
as a means of data and media 
delivery, or soon will be. But 
when done right, as it has 
been with Millenniata’s 
M-Disc (mdisc.com), 
optical has a particu-
lar advantage—lon-
gevity. Hard-disk 
mechanisms fail, 
and the data stored 
on them can be 
erased by magnetic 
fields. Tape stretches 
and is also magnetical-
ly vulnerable. NAND 
won’t last forever, because 
cells leak and eventually fail. 
That leaves M-Disc looking pret-
ty good in the media-preservation, 
aka archiving, role.
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Optical is dead. Long live optical.
In the enterprise, optical has enjoyed continued success. Companies 
such as Sony and Panasonic have continued development both 
because of its longevity and the minimal environmental support it 
requires. You think your hard drive generates a lot of heat? Try 
operating thousands of them. AC bills can be rather high.

The advent of relatively unstable, dye-based CD/DVD recordable and 
rewritable, as well as the lack of quality standards governing them, 
caused many users to forget that pressed optical discs are very long-
lived. CDs from the 80’s and 90’s should still play fine, assuming you 
haven’t scratched them up. Same deal with DVD and Blu-ray movies, 
which are manufactured similarly. And, even though few are aware of it, 
write-once BD-R HTL (High to Low, i.e., reflectivity, as in bright to dark) is 
rated to last 100 to 150 years. Why? Because the data layer is a non-
volatile substance, as opposed to the light-sensitive organic dye used in 
CD/DVD-Rx and less expensive BD-R LTH (Low to High, dark to bright).

M-Disc also uses a non-volatile data layer, but it’s an even better, 
rock-like one which is said to last ten times longer than BD-R HTL. If 

This diagram 
illustrates the 
difference 
between dye-
based and 
inorganic 
recordable 
optical discs.
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you can’t trust media that’s rated for 1,000 years, you’re pickier than I 
am. One note: Don’t freak out when you see an M-Disc DVD+R. It’s 
nearly transparent, but there is a data layer present.

DoD tested
As to that thousand-year claim, the U.S. Navy will back that up. It 
tested M-Disc DVD+Rs along with archival-quality DVD+R/RW and 
DVD-R/RW, subjecting them three times to 
a 185-degree, 85-percent humidity, full-
spectrum light environment for 26.25 hours. 
Every DVD failed—except the M-Discs, 
which suffered no noticeable degradation. 
The Department of Defense hasn’t tested 
the new M-Disc BD-R, but as the technology 
is largely the same, the results should be as 
well. (We’d guess that BD-R HTL would 
survive as well.)

The only failure point for the material 
used in the M-Disc data layer is oxidation, which, according to 
Millenniata materials scientists, shouldn’t be an issue for about ten 
millennia. Yikes. The comparative delicacy of the polycarbonate outer 
layer of the disc is why the media lasts “only” a thousand years.

DVD and Blu-ray Compatibility
I’m not going to live a thousand years, so the only thing I could test was 
compatibility. Millenniata was nice enough to send me an M-Disc–
compatible optical writer, the Samsung/TSST SE-506CB.RSBD, for write 
testing. I also tried a vintage 2006 Plextor PX-B320SA, but it didn’t 
recognize the M-Disc BD-R media as legitimate media for writing.

As BD-R HTL was part of the Blu-ray standard, and M-Disc functions 
much the same way, any BD burner is physically capable of writing 
M-Disc BD media. But as my experience with the PX-B320SA proved, if 
the firmware doesn’t like it, it won’t work.

The logo on the front of an optical burner is actually only for M-Disc 

You should see a logo like 
this on compatible DVD 
burners.



DVDs, and then only for writing, as many non-logo drives will read it 
just fine. Laser strength must be increased beyond that normally used 
with CD/DVD R/RW to ablate the data layer in M-Disc DVDs, so 
compatible firmware must be in place. Older drives could be upgraded 
for writing, but as there’s little financial incentive, don’t hold your 
breath.

The SE-506CB.RSBD burned flawlessly, so I took the discs it created 
and tried to read them using every drive I could find. M-Disc says its 
recordable DVDs should be readable in 90 percent of the DVD drives 
installed, or being sold now. I didn’t hit 90 percent, but even though 
recognition could be slow, the majority of the drives I tested read 
M-Disc just fine (see the table on the next page).

Though your old drive might work fine, if you’re going to commit to 


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optical for the long haul, it 
might not be a bad idea to 
grab one of the latest, 
greatest Blu-ray burners. 
Make sure it supports 
triple-layer, 100GB BDXL 
for less disc swapping.

Not dirt-cheap 
and other 
negatives
M-Disc released 4.7GB 
DVD discs, which are suitable for archiving documents and perhaps 
your most treasured photos, last year. For video or other larger files, 
the recently released 25GB and 100GB BD-R, as well as the soon-to-
be-released (Q3) 50GB BD-R discs should take 
care of business.

But M-Discs aren’t cheap. At retail, the DVDs 
are about $3, the 25GB discs about $5, the 
upcoming 50GB discs around $10, and the 
100GB $20 or so. Just keep in mind that this is 
not media that you’ll have to roll over every 
few years, as with CD/DVD R/RW or dye-
based BD-R LTH. It’s a one-time deal. At least 
until the next technological storage shift.

Because the media is expensive and not as 
capacious as a hard drive, you’ll have to 
choose what’s really important and perhaps 
divvy it up across discs. You may view this 
either as an opportunity to clean house or as 
a deal-buster.

Also, as always, optical is relatively slow: M-Disc BD discs write at a 
rather pokey 4X/18MBps (6X/27MBps is the BD max), and M-Disc DVD 
is also 4X, or 5.28MBps. That’s way off the DVD maximum, which is 16X 

M-Disc BD-R  
three-pack.

Make and Model Read M-Disc DVD Read M-Disc BD-R

LG WH16N540 Yes Yes

Asus DRW-24B1ST No N/A

Teac DV-W516C No N/A

Matshita BD-MLT UJ272 Yes Yes

Matshita UJ8B0AW Yes N/A

TSST SN-208FB Yes N/A

Teac DV-W28S-V Yes N/A

Plextor PX-B320SA Yes Yes
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or 21MBps. But it’s a once-in-a-while deal, so just start your backup, 
minimize it, and go on about your business.

Why not online archiving?
Online archiving is certainly an option, but even in the age of 
ubiquitous broadband, online storage is relatively slow, even slower 
than optical in many cases. And relatively expensive. And unavailable 
when communications systems are down. You don’t know who has 
access to the data, and you don’t 
know how well the data center is 
backed up.

Yes, I have a streak of paranoia, but 
it’s born of experience. There’s 
nothing quite like knowing there’s a 
backup in your safe deposit box or at 
your relatives’ house. Not that you 
shouldn’t store a copy online as well.

I’d strayed from optical for all the 
usual reasons: lack of speed and capacity, expense, bad discs, etc. But 
I’m back and fully intend to keep my most important data, the stuff 
that can’t be replaced, archived on M-Disc. BD-R HTL would do, but 
just in case I do live a thousand years, I’ll use M-Disc. 

There’s nothing quite like 
knowing there’s a backup in 
your safe deposit box or at 
your relatives’ house. Not 
that you shouldn’t store a 
copy online as well.
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EVGA GeForce GTX 980 Ti 
Superclocked+ unleashes 
Maxwell’s true power
BY BRAD CHACOS

I EAGERLY ANTICIPATED reviewing the most powerful single-GPU 
graphics card to ever grace PCWorld’s test bench—and I wasn’t 
disappointed. But the card that claimed that title wasn’t the one I 
expected! While AMD’s new, hotly anticipated Radeon R9 Fury X is a 
beast in its own right, the title of new heavyweight champion instead 
lies with EVGA’s $680 GeForce GTX 980 Ti Superclocked+ with ACX 2.0+ 
(go.pcworld.com/evgagtx980ti), a custom-cooled, overclocked variant 
of Nvidia’s ferocious GTX 980 Ti.

EVGA sent me this card out of the blue on the same day I 
received the Fury X—a coincidence, I’m sure. But 
the GTX 980 Ti Superclocked+ 
doesn’t just triumph 
over AMD’s 


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new flagship, it outpunches Nvidia’s own $1,000 Titan X in raw 
firepower.

What’s more, even though AMD’s dual-GPU Radeon R9 295x2 still 
manages to outrun EVGA’s beast, the GTX 980 Ti Superclocked+ 
illuminates a key advantage the 980 Ti family holds over all other 
4K-capable graphics cards.

Let’s dig in!

EVGA GeForce GTX 980 Ti Superclocked+ under 
the hood
For the most part, EVGA’s card rocks the same basic tech specs as the 
reference GTX 980 Ti, which we covered in full in our initial review of 
Nvidia’s gaming Goliath (go.pcworld.com/nvidiagtx980rev). You find 
the same 2,048 CUDA cores, the same 6GB of GDDR5 memory with a 
7Gbps clock speed and a 384-bit bus, the same port selection, et cetera. 
You can find more details about Nvidia’s GM200 chip itself in our earlier 
review. The chart on the next page has the basic technical information, 
specifically for the EVGA GTX 980 Ti Superclocked+ (henceforth to be 
referred to as the GTX 980 Ti SC+).

So what makes the EVGA GTX 980 Ti SC+ so special? The (full) name 

Details about the 
EVGA GeForce 
GTX 980 Ti 
Superclocked+’s 
ACX 2.0+ cooling 
solution.
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gives it all away. The card ditches the GTX 980 Ti’s reference cooling in 
favor of EVGA’s respected ACX 2.0+ cooling system, which has made an 
appearance on several Nvidia GPUs at this 
point. Rather than talking about its dual 
fans, custom heat pipe, MOSFET cooling 
pipe, and quiet operation yet again, we 
provide an EVGA-supplied diagram 
showing it all on the previous page. You’ll 
see the results in our benchmarking 
section.

The other tell-tale in the name is Superclocked+. The drastic cooling 
enhancements provided by 
ACX 2.0+ let EVGA 
positively crank the core 
clock speed on this bad boy, 
a tweak that helps it beat 
both the Fury X and the 
Titan X out of the box. 
While the stock GTX 980 Ti 
is clocked at 1,000MHz 
base clock/1,075MHz boost 
clock, EVGA’s managed to 
coax those numbers up to 
1,102MHz base/1,190MHz 
boost in the GTX 980 Ti 
SC+—a sizeable jump.

Getting that kind of 
overclock out of the box, 
with full 3-year warranty 
support, is no joke.

If you want to push things 
even further—or boost the 
memory speed, which is 
left untouched from stock 

Specifications

Effective

Dimensions

DISPLAY 
PORT

DISPLAY 
PORT

DISPLAY 
PORT HDMIDVII

Getting that kind of 
overclock out of the box, 
with full 3-year warranty 
support, is no joke.





on the GTX 980 Ti SC+—you can turn to EVGA’s stellar PrecisionX 
overclocking software, which is available as a free download on EVGA’s 
website (go.pcworld.com/precisionx) or via Steam (go.pcworld.com/
precisionxsteam). It’s a great solution, blending user-friendliness with 
the fine-tuning features power users demand. Need a primer? 
PCWorld’s overclocking guide (go.pcworld.com/overclockgc) refers to 
MSI’s competing Afterburner tool, but the same basic overclocking 
principles apply with PrecisionX.

One final design tidbit: EVGA’s GTX 980 Ti SCi+ comes with an eye-
catching custom backplate installed. Unlike the vanilla GTX 980, the 
reference GTX 980 Ti eschewed a backplate, ostensibly to facilitate 
better airflow in multi-GPU setups, but I’m a sucker for a nice 
backplate. Who wants to stare at exposed circuit boards?

EVGA GeForce GTX 980 Ti Superclocked+ 
benchmarks
With that out of the way, let’s get to the fun part.

As always, we reviewed the GTX 980 Ti on PCWorld’s graphics testing 
system. You can see how we built the system here, but here are the 
basics:

Intel’s Core i7-5960X with a Corsair Hydro Series H100i closed-
loop water cooler, to eliminate any potential for CPU bottlenecks 
affecting graphical benchmarks
An Asus X99 Deluxe motherboard
Corsair’s Vengeance LPX DDR4 memory, Obsidian 750D full 
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The EVGA 
GeForce GTX  
980 Ti Super-
clocked+’s 
backplate.
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tower case, and 1200-watt AX1200i power supply
A 480GB Intel 730 series SSD
Windows 8.1 Pro

I’ve already spoiled the results by calling this the fastest graphics 
card we’ve ever tested, but if you’re looking to game at high or ultra 
graphics settings at 4K resolution, the same caveats mentioned in our 
Fury X, Titan X, and reference GTX 980 Ti still apply. While all of these 
cards are fully capable of handling 4K gameplay by their lonesome, 
frame rates can still hover between 30 to 60 fps in some titles, 
depending on the settings you’re using.

A G-Sync monitor, which forces your graphics card and display to 
synchronize frame rates, greatly improves the experience when 
gaming at 4K by smoothing everything out and essentially killing both 
screen tearing and stuttering. Simply put, G-Sync (and AMD’s 
competing FreeSync displays, designed for Radeon cards) are 
wonderful. If you can afford to pick up a G-Sync monitor to pair with 

Middle Earth: Shadow of Mordor
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EVGA’s GTX 980 Ti SC+, it’s highly recommended.
The GTX 980 Ti’s cranked clock speeds help it shine in every test I 

ran. First up: Middle-earth: Shadow of Mordor. The game itself is great, 
but more importantly, it comes with an in-game benchmark and an 
optional Ultra HD Textures pack that hammers the memory of even 
the most capable cards on the market today. It’s tested using the 
game’s Medium and High presets, then shifting to the Ultra preset 
and then cranking every graphics option to its highest possible 
setting—which even the Ultra preset doesn’t actually do. (Note: No 
matter which drivers I’m using, I just can’t coax Shadow of Mordor into 
playing nice with AMD’s dual-GPU Radeon R9 295x2.)

The long-awaited Grand Theft Auto V is finally available on PCs, and 
with all the bells and whistles on, it can be a bear. We tested it by 
enabling all the advanced video options, then shifting all the graphics 
settings and sliders to their highest settings. I tested it with 4x MSAA 
and 4x MSAA reflections enabled to push the active memory use over 
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4GB, as well as with the MSAA options disabled to bring it just under 
4GB—primarily to test the Fury X’s 4GB of cutting-edge high-
bandwidth memory at 4K resolution. To see complete benchmark 
results from all of our tests, go to go.pcworld.com/evgabench. 
Sleeping Dogs: Definitive Edition is a recent remake of a wonderful older 
game, but don’t let that fool you: It can make even the most powerful 
graphics cards in the land sweat when you enable all its graphics 
options. Only the Radeon R9 295x2 hits 30 fps at 4K resolution, and 
although results at 2560 x 1600 resolution aren’t shown here, not 
even that card can hit 60fps at that lower resolution on extreme 
graphics settings.

Alien Isolation is the best xenomorph experience since the original 
Alien movie, and when it comes to graphics, it scales well across all 
hardware.
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Dragon Age: Inquisition is drop-dead gorgeous and one of the best PC 
games of 2014. Despite being heavily promoted by AMD at its launch, 
the game performs better on Nvidia hardware. 

We tested Metro Last Light Redux with SSAA and Advanced PhysX 
disabled. SSAA cuts frame rates in half for negligible visual gain.

Bioshock Infinite is getting a bit long in the tooth, but it uses the 
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popular Unreal Engine 3 and both AMD and Nvidia have had plenty of 
time to optimize their drivers for the game by this point.

Next up: The 3DMark Fire Strike and Unigine Valley synthetic 
benchmark tests. Fire Strike Ultra is a more demanding variant of the 
base Fire Strike benchmark, built specifically to test 4K gaming 
capabilities.  

Power usage and thermal testing is conducted by running the 
grueling Furmark tool for 15 minutes. Thermals are measured at the 
end of the run, using both Furmark’s built-in temperature tool as well 
as SpeedFan. Power usage is measured on a whole-system basis, 
rather than the individual cards themselves, by plugging the PC into a 
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Watts Up meter.
The GTX 980 Ti SC+’s custom cooling solution helps it shave a full 9 

degrees Celsius off the power use at load when compared to the 
reference GTX 980 Ti. And while it doesn’t show in the raw 
benchmarks—I don’t have a decibel meter on hand—EVGA’s card runs 
pretty damned quiet, even when you’re hammering it with a 
demanding game. (Though obviously not as cool or quiet as AMD’s 
Fury X and R9 295x2, each of which uses an integrated closed-loop 
water cooler.)
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Bottom line
The EVGA GeForce GTX 980 Ti Superclocked+’s outstanding perfor-
mance comes as no surprise. The reference GTX 980 Ti was already a 
beast in every sense of the word, so slapping a slick custom cooler on 
it and cranking the clock speeds was guaranteed to turn the GTX 980 
Ti SC+ into a true barn-burner. EVGA’s excellent build quality and 
design thoughtfulness is just icing on the delicious cake.

You could push frame rates to even more blistering levels with 
esoteric liquid-cooling solutions that allow for higher overclocks—
witness EVGA’s own GeForce GTX 980 Ti Hydro Copper and GeForce 
GTX 980 Ti Hybrid, with their insane 1,228MHz boost clock speeds out 
of the box, for evidence of that. Meanwhile, some other cards, like 
MSI’s GTX 980 Ti Gaming 6G, manage to push the boost clock speeds 
beyond that. Those cards would no doubt hit frame rates even higher 
than the ones the GTX 980 Ti SC+ achieved here.

But as it stands, the EVGA GeForce GTX 980 Ti Superclocked+ is 
hands-down the fastest single-GPU graphics card we’ve ever tested, 
barely coming in second to only the formidable dual-GPU Radeon R9 
295x2 (and its integrated closed-loop water cooler) in our testing. It’s 
a thrilling example of the kind of firepower that a custom-cooled, 
sped-up GTX 980 Ti can bring to the table—something that the 
flagship Titan X and Fury X can’t offer, with Nvidia 
and AMD locking those cards down to reference 
designs only.

Hail to the new king, baby.
Finally, the sterling performance of the $680 GTX 
980 Ti SC+ is yet more proof that gamers should 
pass on the beastly $1,000 Titan X, even with the 
latter’s 12GB of RAM. If you picked up one of 
those Titan X’s when it was the clear lord of the 
land a few scant months ago…well, there’s a 
reason that graphics card lust is the cruelest obsession. 
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Radeon R9 Fury X graphics  
card: AMD’s long-awaited  
4K powerhouse
BY BRAD CHACOS

AMD’S RADEON R9 Fury X kicks ass.
It’s important to note that right up front, because AMD’s graphics 

division has had a rough year. The company’s been forced to watch 
Nvidia release not one, not two, but five new GeForce graphics cards—
the entire GTX 900-series line—since the Radeon R9 285 launched 
last September. What’s more, those GeForce cards delivered so much 
performance and sipped so little power that all AMD could 
do in response was steeply slash the prices of its 
Radeon R200-series graphics cards to stay 
competitive. And AMD’s “new” Radeon R300-series 
cards are basically just tweaked versions of the 
R200-series GPUs with more memory.

Through it all, the promise of the water-
cooled Radeon R9 Fury X (go.pcworld.com/
fury) glimmered as the light at the end of the 
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tunnel, first through unofficial leaks and then through official reveals. 
It’ll have cutting-edge high-bandwidth memory! It’ll have a new Fiji 
graphics processor with an insane 4,096 stream processors! It’ll have 
an integrated closed-loop water cooler! It’ll play 4K games and go toe-
to-toe with Nvidia’s beastly Titan X and GTX 980 Ti!

And it’s all true. Every last bit of it. The Radeon R9 Fury X kicks ass.
It’s not quite the walk-off home run that Team Red enthusiasts were 

hoping for, however—and AMD’s claim that the Fury X is “an 
overclocker’s dream” definitely does not pass muster.

Let’s dig in.

AMD’s Radeon R9 Fury X under the hood
There isn’t much mystery to the Fury X’s technical specifications at 
this point. AMD long ago provided a deep-dive into the card’s HBM 
implementation (go.pcworld.com/hbm) and described the Fury X’s 
technical and design details (pcworld.com/furyxtechspecs) with 
loving exactness. We’ll cover the high points here, but check out our 
previous coverage if you’re looking for more details.

The most notable technical aspect of the Fury X is its use of high-
bandwidth memory, making it the first graphics card to adopt HBM. 
AMD says it’s been developing the technology for seven years, and 

A diagram of AMD’s 
HBM implementation.
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Nvidia’s not expected to embrace similar technology until 2016 at the 
earliest, when its Pascal GPUs launch.

HBM stacks DRAM dies one atop the other, then connects 
everything with the GPU using “through-silicon vias” and “μbumps” 
(microbumps). The stacking lets 1GB of HBM consume a whopping 94 
percent less on-board surface area than 1GB of standard GDDR5 
memory, which enabled AMD to make the Fury X a full 30 percent 
shorter than the Radeon R9 290X.

While GDDR5 memory rocks high clock speeds (up to 7Gbps) and 
uses a smaller interface to connect the GPU—384-bit, or 512-bit in 
high-end graphics cards—HBM takes the opposite approach. The Fury 
X’s memory is clocked at a mere 1Gbps, but travels over a 
ridonkulously wide 4,096-bit bus to deliver effective memory 
bandwidth of 512GBps, compared to the GTX 980 Ti’s 336.5GBps. All 
that memory bandwidth makes for great 4K gaming, though it 
doesn’t give the Fury X a clear edge over the 980 Ti when it comes to 
games, as we’ll see later.

Technological limitations capped this first-gen HBM at just 4GB of 
capacity. While AMD CTO Joe Macri told us in May that’s all developers 
really need for now, it definitely proved to be a problem in our testing 
when playing games that gobbled up more than 4GB of RAM—Grand 

HBM space 
savings over 
GDDR5.
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Theft Auto V, 
specifically. Gaming 
at 4K resolution can 
eat up memory fast 
once you’ve 
enabled any sort of 
anti-aliasing.

Moving past 
memory, AMD’s new 
Fiji GPU is nothing 
short of a beast, 
packed to the gills with a whopping 4,096 stream processors—
compared to the R9 290X’s 2,816—and 8.9 billion transistors. It’s 
clocked at 1,050MHz, promises 8.6 teraflops of compute performance, 
and draws 275 watts of power through two 8-pin power connectors 
that can draw up to 375W.  

The Radeon R9 Fury X over the hood
AMD spared no expense on the physical design of the Fury X, either. 
The 7.5-inch card is built from multiple pieces of die-cast aluminum, 
then finished with a black nickel gloss on the exoskeleton and soft-
touch black everywhere else. Everything’s covered, even the sides and 
back of the card. There’s not even an exhaust grille on the I/O plate, 
which rocks a trio of full-sized DisplayPorts and an HDMI port that’s 
sadly limited to the HDMI 1.4a specification. The decision not to go 
with HDMI 2.0 limits 4K video output to 30Hz through the HDMI port, 
so gamers will want to stick to using the DisplayPorts.

You’ll find an illuminated red Radeon logo on the outer edge and 
face of the card, along with a new “GPU Tach” (as in “tachometer”) 
feature that places 8 small red LEDs above the power connections. The 
harder you push the card, the more LEDs light up. It’s super-dumb but 
honestly, it thrilled me to no end watching those little LEDs flare to life 
when booting up a game. There’s also a small green LED next to those 
that illuminates when AMD’s ZeroCore technology puts the Fury X to 
sleep. This thing screams “premium.”

REVIEWS  
& RATINGS

AMD’s Fiji 
GPU.





See the GPU 
Tach LEDs just 
above the two 
8-pin power 
connectors?

That extends to the Fury X’s cooling 
system. Rather than going with a typical 
air-cooling solution, with a fan or blower, 
the Fury X utilizes an integrated closed-
loop liquid cooler that’s basically a more 
refined version of the beastly Radeon R9 
295x2’s water-cooling setup. It’s a slick 
custom design built in conjunction with Cooler Master, 
rocking a 120mm fan from Nidec on the radiator. AMD says the cooler 
itself is rated for up to 500W of thermal capacity.

Deploying water-cooling indeed keeps the Fury X running nice and 
cool. Despite AMD’s claim that the fan stays more than 10 decibels 
quieter than the Titan X’s air-cooled blower, however, I was surprised 
by just how much noise it puts out. Subjectively—as I don’t have a 
decibel meter on hand—the Fury X’s radiator fan creates more sound 

than the fan on 
Nvidia’s reference 
GTX 980 Ti and AMD’s 
own R9 295x2, 
though I still wouldn’t 
call it loud.

The braided cables 
connecting the 
radiator to the card 
itself are a nice touch 
and far more 
aesthetically 
appealing than the 
R9 295x2’s plastic 
tubes. Be mindful of 
where you place the 
discrete radiator/fan 
combo, however: At 
2.5 inches of total The AMD Radeon R9 Fury X’s technical specifications.
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width (the same as the R9 295x2’s), they jut far enough into the case 
of PCWorld’s GPU testing machine (go.pcworld.com/diygamingpc) to 
bang against our CPU’s closed-loop liquid cooling. 

Final design note: You won’t be able to buy aftermarket variants of 
the Fury X with custom cooling or hefty overclocks applied by add-in 
board vendors like Asus or Sapphire. AMD says the Fury X is a reference 
design only, though the air-cooled Radeon R9 Fury has vendor-
customized designs available.

The elephant in the room
Normally, this is where I’d leap into gaming benchmarks, but I wanted 
to talk about a more advanced issue first: overclocking.

With power pins capable of sucking down 100W of additional 
energy, a liquid-cooling solution rated for up to 500W of thermal 
capacity, and a redesigned AMD PowerTune/OverDrive that gives you 
more control over fine-tuning your card’s capabilities, the Radeon R9 
Fury X seems tailor-made for hefty overclocking. Heck, AMD even 
touted the card’s overclockability (that’s a word, right?) at its E3 
unveiling. “You’ll be able to overclock this thing like no tomorrow,” 
AMD CTO Joe Macri said. “This is an 
overclocker’s dream.”

That’s… well, that’s just not true, at 
least for the review sample I was given.

I was only able to push my Fury X 
from its 1,050MHz stock clock up to 
1100MHz, a very modest bump that 
added a mere 1 to 2 frames per 
second of performance in gaming 
benchmarks. You can’t touch the 
HBM’s memory clock—AMD locked it down. And any time I tried 
upping the Fury X’s power limit in AMD’s PowerTune utility, even by 1 
percent, instability instantly ensued.

An AMD representative told me that “We had a very limited number 
of OC boards.” When I asked whether there will be different variants of 

AMD Radeon 
Fury X with 
cooler.
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the Fury X, given this “OC board” talk, I was told that there will only be 
one SKU, and it’s the usual “silicon lottery” when it comes to your 
GPU’s overclocking capabilities. (Overclocking capabilities vary from 
individual GPU to individual GPU; another Fury X could have much 
more headroom than ours, for example.)

All that said, we’ve heard through the grapevine that we’re not the 
only ones experiencing disappointing overclocks with the Fury X, 
either. So if you’re considering picking up a Fury X, peruse the 
following gaming benchmarks knowing that you may not be able to 
eke out additional performance via overclocking.

AMD Radeon R9 Fury X gaming benchmarks
Enough preamble! Let’s dive into the nitty-gritty.

As with all of our graphics card reviews, I benchmarked the Radeon 
R9 Fury X on PCWorld’s GPU testing system, which contains:

> Intel’s Core i7-5960X with a Corsair Hydro Series H100i closed-loop 
 water cooler, to eliminate any potential for CPU bottlenecks 
 affecting graphical benchmarks

> An Asus X99 Deluxe motherboard
> Corsair’s Vengeance LPX DDR4 memory, Obsidian 750D full tower 

 case, and 1200-watt AX1200i power supply
> A 480GB Intel 730 series SSD
> Windows 8.1 Pro
As far as the games go, we used the in-game benchmarks provided 

with each, utilizing the stock graphics settings mentioned unless 
otherwise noted. We focused on 4K gaming results for this review. 

I’ve compared the Fury X against Nvidia’s reference GeForce 980 Ti, 
GeForce 980, and the $1,000 Titan X, as well as AMD’s older Radeon R9 
290X and the Radeon R9 295x2, which packs two of the Hawaii GPUs 
found in the R9 290X. I’ve also included benchmarks from a card that we 
don’t yet have a formal review for: EVGA’s $680 GeForce GTX 980 Ti 
Superclocked+ (aka the GTX 980 Ti SC+), an aftermarket version of the 
GTX 980 Ti that sports EVGA’s popular ACX 2.0+ dual-fan cooling system.

EVGA sent me the GTX 980 Ti SC+ on the same day AMD passed me 
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the Fury X—pure coincidence, I’m sure. 
Let’s kick things off with Middle-earth: Shadow of Mordor. This nifty 

little game gobbled down tons of industry awards and, more 
importantly for our purpose, offers an optional Ultra HD textures pack

Shadow of Mordor
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AMD Radeon 
Fury X with 
split view.

that is only recommended for 
cards with 6GB or more of 
on-board memory. That doesn’t 
hinder the Fury X’s ability to 
come out swinging with slightly 
higher frame rates than the 
reference GeForce GTX 980 Ti—no 
small feat, especially when the game 
opens with a splash page championing 
Nvidia technology.

The game was tested at Medium and High quality graphics 
presets, then by using the Ultra HD Texture pack and manually 
cranking every graphics option to its highest available setting, which 
Shadow of Mordor’s Ultra setting doesn’t actually do. The R9 295x2 
consistently crashes every time I attempt to change Mordor’s 
resolution or graphics settings, hence the zero scores. (Ah, the joys of 
multi-GPU setups.)

Sleeping Dogs: Definitive Edition absolutely murders graphics cards 
when the graphics settings are set to Extreme at high resolutions. 
Only the dual-GPU Radeon R9 295x2 hits 30 fps at 4K resolution, 
though the Fury X hangs with its Nvidia counterparts. You can view 
detailed results of our tests at: go.pcworld.com/furyxbench.  

The Fury X also hangs tight with the reference GTX 980 Ti in Metro 
Last Light Redux, which we test with PhysX and the frame rate-killing 
SSAA options disabled. EVGA’s version of the GTX 980 Ti trumps all 
single-GPU comers, though the dual-GPU Radeon R9 295x2 fires on all 
cylinders in this title.

The Fury X and reference 980 Ti are neck and neck in Alien Isolation, a 
game that scales well across all hardware types and falls under AMD’s 
Gaming Evolved brand.

The gorgeous Dragon Age: Inquisition also partnered with AMD at its 
launch, but Nvidia’s cards maintain a clear lead. Note that the R9 
295x2 apparently doesn’t have a working CrossFire profile for the 
game, so it drops down to using a single GPU.


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The same goes for Sniper Elite 3. Note that we didn’t have a chance 
to test the reference GTX 980 Ti here.

We also tested the Fury X and EVGA’s 980 Ti Superclocked+ in Grand 
Theft Auto V, because the game is notorious for demanding more than 
4GB of memory—HBM’s top capacity—at high resolutions.

We tested the game three ways at 4K resolution. First, by cranking 
all the sliders and graphics settings to their highest settings, then 
enabling 4X MSAA and 4X reflections MSAA in order to hit , of RAM 
usage; then, using the same settings but disabling all MSAA to drop 
the memory usage to 4,029MB, just under the Fury X’s limit; and then 
by testing the Fury X’s chops at normal graphics settings with MSAA 
disabled, which consumes 1,985MB of memory. (We didn’t have time 
to benchmark any other cards, alas.)

The EVGA card pounds the Fury X here—no wonder GTA V wasn’t 
included in the reviewer’s guide benchmarks AMD provided for the 
Fury X. But the frame rate averages alone don’t show the full 
experience: When GTA V was pushed to consume more memory than 
the Fury X has on board, the experience became extremely stuttery, 
choppy, and graphically glitchy as the card offloaded duties to system 
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memory, which is far slower than HBM.
That’s to be expected when a game’s memory use exceeds the 

on-board capabilities of a graphics card, however, which was a big part 
of the reason gamers were in such a tizzy over the GTX 970’s 
segmented memory setup earlier this year, in which the last 0.5GB of 
the card’s 4GB of RAM performs much slower than the rest.

I also tested the systems using three synthetic, but well-respected 
benchmarking tools: 3DMark’s Fire Strike and Fire Strike Ultra, as well 
as Unigine’s Valley. As AMD promised, the Fury X comes out ahead of 
the reference GTX 980 Ti in Fire Strike and Fire Strike Ultra, beating 
even the EVGA variant at the former, perhaps due to HBM’s speed—

Unigine Valley
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though the tables are turned in the Valley results. (See Fire Strike and 
Fire Strike Ultra test result charts at: go.pcworld.com/furyxbench.

To test power and thermal information, I run the grueling Furmark 
benchmark for 15 minutes, taking temperature information at the end 
using Furmark’s built-in tool and double-checking it with SpeedFan. 
Power is measured on a whole-system basis, instead of the GPU alone, 
by plugging the PC into a Watts Up meter rather than the wall socket.

As you can see, the Fury X may technically need only 275W for what 
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AMD calls “typical gaming scenarios” but it draws much, much more 
under Furmark’s worst-case scenario—nearly as much as two GTX 
980s (not Ti’s) in SLI. It drew even more power than the dual-GPU 
Radeon 295x2.

On the positive side, the Fury X runs extremely cool, hitting 56 degrees 
Celsius max after several hours of overclocking. There would be plenty of 
room for overclocking… if the chip itself overclocked worth a damn.

Bottom line
So there you have it: Between the new Fiji GPU and the inclusion of HBM, 
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0 10 20 30 5040 60 70 10090
DEGREES CELCIUS. LOWER IS BETTER

AMD Radeon  
R9 290X  
(reference)

95

Nvidia GTX 980 
(reference) 80

Nvidia 980 Ti 
(reference)

Nvidia GTX  
980 Ti (EVGA)

84

75

Nvidia Titan 
(reference)

Nvidia Titan X 
(reference)

82

83

AMD Radeon 
Fury X

AMD Radeon 
295X2 (XFX)

56

51

80

Nvidia 980 SLI 
(reference) 84





REVIEWS  
& RATINGS

AMD’s Radeon R9 Fury X enters the rarefied air of single-GPU cards 
capable enough to play games at 4K resolutions with high graphics detail 
settings enabled—an exclusive club containing only it, the GTX 980 Ti, 
and the Titan X. (Like the Titan X and 980 Ti, the Fury X struggles to hit a 
full 60fps at 4K/high, however, so if you opt to pick one up you should 
consider picking up a new 4K FreeSync monitor to go with it.)

One more time: The Fury X kicks ass! Both technically and 
aesthetically. AMD needed a hit, and the Fury X is sure to be one with 
Team Red enthusiasts.

That said, it’s hard not to feel a bit disappointed about some aspects 
of the card—though that may have to do more with AMD’s failure to 
manage expectations for it.

After hearing about HBM’s lofty technical numbers for months, it’s 
disappointing to see little to no pure gaming benefits from all that 
bandwidth. After seeing the tech specs and hearing AMD’s Joe Macri 
wax poetic about the Fury X’s overclocking potential, it’s majorly 
disappointing to see it fail so hard on that front, crappy silicon lottery 
draw or no. And while 6GB of RAM is still overkill for the vast majority 
of today’s games, it’s disappointing to see the Fury X limited to just 
4GB of capacity when some of today’s games are starting to blow 
through that at the 4K resolution that AMD’s new flagship is designed 
for, as evidenced by our GTA V results.

The timely arrival of EVGA’s custom GTX 980 Ti, which beats both 
AMD and Nvidia’s reference flagships in raw benchmarks, also takes 
some of the wind out of the Fury X’s sails—wind that can’t be 
countered by AMD’s own hardware partners, because the Fury X is 
limited to reference designs alone.

No, the Fury X isn’t the Titan-killer that Team Red fans hoped it would 
be—but it is a GTX 980 Ti equal. This is nothing short of a powerful, 
thoughtful graphics card that once again puts AMD Radeon on equal 
footing with Nvidia’s gaming finest. Being one of the most powerful 
graphics cards ever created is nothing to sneeze at, especially when 
AMD wrapped it all up in such a lovingly designed package.

AMD’s Radeon R9 Fury X kicks ass…even if it doesn’t make Nvidia’s 
high-end offerings obsolete. 
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BY JASON EVANGELHO

FOR YEARS, AMD has prioritized raw graphics processing horsepower 
over things like power efficiency and quieter operation. Then Nvidia’s 
Maxwell architecture came along and proved that video cards could 
dominate the benchmarks while still sipping power. With the launch 
of the new Radeon Fury X and Radeon R300 series, AMD has 
responded to community criticism and competitive heat with Frame 
Rate Targeting Control, a meaningful feature that has a serious 

Tested: AMD’s Frame Rate 
Target Control delivers real 
benefits for Radeon gamers
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impact on daily gaming sessions.
Frame Rate Target Control (FRTC) is a new 

option in AMD’s Catalyst Control Center 
that lets you set a maximum frame rate 
between 55 frames per second and 95 
frames per second (fps) for the majority of 
DirectX 10 and DirectX 11 games. The 
message from AMD is that FRTC is a triple 
threat of benefits: You’ll dramatically 
reduce your video card’s power 
consumption, decrease fan noise, and lower 
the operating temps of your GPU.

Obviously we had to put those claims to 
the test.

Why AMD’s Frame Rate Targeting  
Control exists
Wait, back up. Why on Gaben’s green earth would we PC gamers—who 
are addicted to stunning eye candy and smooth-as-silk frame rates—
want to limit our fps? Well, there are a ton of games out there that hit 
super-high frame rates on modern video cards. Your PC is effectively 
throwing them away and needlessly taxing your video card on three 
fronts: Power, noise, and temperature. This wasteful behavior 
prompted AMD to design FRTC.

Saving a few bucks on your power bill is likely lower on the priority 
list, but the dog days of summer and scorching GPU temperatures 
don’t mix. Less heat on your card means less stress, and less stress 
means a longer, healthier lifespan for your hardware. Plus, a reduction 
in noise output from our video cards mean more immersion in our 
games.

The need for FRTC made itself abundantly clear when I booted up 
Civilization: Beyond Earth and noticed that literally thousands of frames 
were being wasted in the menus. Per second. Being a fairly lightweight 
game, my fps spiked north of 2,000 inside the menus. I was reasonably 

The Frame Rate 
Target Control 
options in AMD’s 
Catalyst Control 
Center.
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startled when I discovered how much needless electricity that was 
consuming, and the difference it made to GPU temperature and 
overall noise.

Even during normal gameplay, though, the advent of AMD’s 
FreeSync (go.pcworld.com/amdfreesync) has reduced the need for 
insanely high frame rates. The bottom line: Constraining your frame 
rate often has a negligible impact on the overall gameplay experience, 
and as you’ll see in a minute, the benefits to doing so might be worth 
pursuing.

Frame Rate Targeting Control tested
We rounded up AMD’s new flagship Radeon Fury X and a Sapphire Tri-X 
Radeon 390x to observe FRTC’s impact on both liquid-cooled and 
traditional air-cooled video cards. We then fired up Dirt Rally, BioShock 
Infinite, and Civilization: Beyond Earth at 1440p and measured minimum 
and maximum system power draw levels with FRTC off, capped at 55 
fps, and capped at 75 fps.

To get a good bead on any noise level and GPU temperature 
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improvements, we ran the Heaven Valley benchmark in 15-minute 
loops and took note of peak decibel levels and temps under load once 
the cards were nice and warmed up.

With FRTC off and Heaven Valley set to Medium quality at 1440p, 
frame rates ranged from 75 fps all the way up to 120 fps, depending 
on scene complexity. What happens when we put a leash on those 
frames? The already-cool Fury X sees a 15-percent temperature 
reduction, and Sapphire’s air-cooled 390x reaps the identical benefit, 
dropping from 71 degrees Celsius down to 60 degrees Celsius.

No one enjoys a noisy graphics card whirring away in their chassis, 
which is why it’s awesome to see that FRTC has notable influence over 
noise levels. Sapphire’s 390x starts off reasonably quiet, but with FRTC 
capped at 55 fps (currently the lowest setting possible), it dives from 
66dB to 59dB. On the surface that might seem inconsequential, but 
decibels are measured in increasing magnitudes of intensity. This 
translates to a card that isn’t merely 7dB quieter—it’s 1.6x quieter.
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So how about AMD’s power consumption claim? Does trimming the 
frame-rate fat really result in less system power pulled from the wall? 
It does indeed.

Take a look at that BioShock Infinite chart, especially the Fury X 
results. It’s a power hog with its frame rate left unencumbered (in the 
low to mid 100s). The minimum amount of power drawn from the wall 
while running with FRTC off is higher than the maximum power draw 
with FRTC set to 55 fps. All told, it’s a healthy 34 percent reduction in 
wattage at the wall. Other high-frame-rate titles like Civilization: 
Beyond Earth and Dirt Rally exhibit similar—if a bit more minor—
energy savings.

System Power Draw: Bioshock Infinite
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Bottom line
So with a simple Catalyst Control Center tweak that taps into Radeon 
300 series graphics cards and AMD’s Fury lineup, we see a meaningful 
set of benefits. AMD’s Frame Rate Target Control makes your PC 
gaming sessions more enjoyable by turning down the ambient 
volume, dropping the degrees, 
saving you a few bucks at the wall, 
and likely extending the life of 
your video card by removing some 
unnecessary stress.

There’s one minor quibble worth 
pointing out. Originally we 
wanted to test Blizzard’s Heroes of 
the Storm, but found that FRTC 
had no effect on it. We then bounced over to Diablo III, and FRTC was 
once again ineffective. At this point we suspect it’s a glitch with 
Battle.net titles, at the very least within our test environment. An 
inquiry to AMD has gone unanswered as of this writing.

That said, we’ve been impressed with Frame Rate Target Control. 
The experience is augmented even further when you incorporate one 
of AMD’s FreeSync panels, which allows your display to dynamically 
sync its refresh rate with your GPU, eliminating screen tearing and 
input lag from the equation. But with or without FreeSync, FRTC is a 
very welcome new feature in AMD’s software ecosystem.

Update: After our tests were completed, AMD released Catalyst 15.7 
WHQL (go.pcworld.com/amdcatalyst157) drivers  which extended 
both FRTC and AMD’s virtual super resolution to the vast majority of 
Radeon R200-series and Radeon R00-series graphics cards, as well. 

We’ve been impressed 
with Frame Rate 
Target Control while 
thoroughly testing it 
over the past few days. 
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BY GORDON MAH UNG

Batman: Arkham Knight: How 
bad are the issues? Pretty bad.

AFTER PLAYING THE Batman: Arkham Knight game on several PCs, it’s 
obvious why WB Games decided to suspend sales.

PC gamers, we should have expected this. 
Despite this year being our year, with our own dedicated PC-gaming 

show at E3, Batman: Arkham Knight (batmanarkhamknight.com) is an 
unkindly reminder of where we stand with game developers: Console 
gamers got a brilliantly crafted game while we’re stuck with a 
standard-issue, glitch-filled port.

At least that’s what nearly 8,000 and counting people on Steam are 
saying about this brand-new game. The torches and pitchforks 
became numerous enough that WB Games made the nearly 



unprecedented decision to  indefinitely 
suspended sales of the PC version 
of  Arkham Knight until its problems can be 
resolved.

As one of the hottest games of the 
season, Batman: Arkham Knight had big 
marketing dollars behind it and a strong 
Metacritic score of 89 filling its sails. Every 
one of those critics, however, reviewed 
the PlayStation 4 version. No reviews of 
the PC port were published before the 
game was shipped.

With thousands of people who purchased the PC version filing 
complaints about texture flashing, crashing, stuttering, and terrible 
frame rates, Batman: Arkham Knight is what’s technically called a hot 
stinking mess.

To find out just how bad it was, I fired up Batman: Arkham Knight on 
the most powerful gaming PC I had on hand: a 4-way SLI GeForce Titan 

Want to know what Batman: Arkham Knight looks like with 
4-way Titan X in SLI and a Core i7-5960X overclocked to 
4.5GHz? This 4K resolution error message.

Watch the 
video at

go.pcworld.
com/arkham 

knightvid
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X rig with a Core i7-5960X overclocked to 4.5GHz, RAIDed SSDs, and 
16GB of DDR4/2666 RAM. What does $11,000 worth of fire-breathing, 
meat-eating metal get you? How about 30 frames per second? ( Insert 
needle-scratch sound.)

And no, that’s not at surround 4K or straightforward 4K resolution. 
WB Games decided to lock Arkham Knight down to 30 fps no matter 
what hardware you’re running. Whether it’s a GeForce GTX 960 or a 
four-way GeForce Titan X setup, this game will max out at 30 frames 
per second running on a PC.

The good news is there’s a workaround, but you’ll need to dig into an 
INI file rather than, oh, use an in-game switch. 

Backup your game first, and then dig into C:\ProgramFiles(x86)\
Steam\ steamapps\common\Batman Arkham Knight\BMGame\
Config, and then open BmSystemSettings.ini in Notepad and look for 
the line that says MaxFPS=30.000000. Changing that to either 60 or 
120 will allow the game to run at higher frame rates.  

Setting PhysX 
to run on GPU 
number four 
would at least 
get the game 
to run for me.
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But then there’s crashing 
too 
On my 4-way system, I initially ran the 
game at 1080p to see if issues would 
crop up; but once I’d changed that .
INI file, I decided to let it run in its full 
4K glory: I was immediately greeted 
with the game crashing as soon as I 
tried to run it in benchmark mode. 
After that crash, it never went back 
to working without mucking around. 
Even setting the .INI file back to a 
maximum of 30 fps didn’t help. 

Through this mucking around, I determined that the only way to get 
it to run was to follow WB Games’ advice (go.pcworld.com/
arkhampcupdate) to dedicate one of my GPUs to PhysX to help 
“performance.” It didn’t help performance in my experience, but it at 

Batman: Arkham Knight 4K performance
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least made it so I could play the game. 
All of my issues, mind you, were with 
the recommended Nvidia 353.30 
GameReady driver that technically 
supports SLI. More on this later.

Letting the Nvidia driver 
automatically select the GPU to run 
PhysX on would cause a crash. And in 
the bizarre column, depending on 
which GPU you ran, PhysX would limit 
your SLI support. Run PhysX on GPU 
number one or two and you get no SLI 
support whatsoever. Run it on GPU 
number four and you get SLI or two 
GPU’s only. Running it on GPU number 
three though, would get you tri-SLI at 
least, with only occasional crashes to 
the desktop.  

One reliable way I could get the 
game to run on all four GPUs, at least 
according to the Nvidia control panel, 
was to run PhysX on the CPU. But that 
turned off the game’s Interactive 
Smoke and Paper Debris settings. And 
as controversial as GameWorks and 
PhysX are to gamers who run AMD 
video cards, the effects in Batman: Arkham Knight are beautiful.

It’s only after seeing Batman: Arkham Knight with the smoke and 
paper effects on and off that you realize what you’re missing. It’s 
almost enough to make someone who doesn’t like proprietary 
technology forgive the game for using those Nvidia-only features. I 
mean, that smoke is wondrous. Watch the video and you can see it curl 
as the Batmobile peels down the street.

The game’s performance is another head-scratcher. Let me remind 

The smoke in this scene looks dramatically better with 
GameWorks fog and paper effects and PhysX enabled.

You can love or hate GameWorks, but having the 
smoke effects turned off makes the Batmobile’s 
burnout look wimpy. This would get you negative 
feedback at an Oakland sideshow.
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you, I’m running the game on an 8-core Core-i7 rig 
with four water-cooled Titan X cards. This rig pushes 
Middle-earth: Shadow of Mordor, with its HD textures 
at 4K resolution, at 100 fps. It plays Tomb Raider at 4K 
on Ultimate at nearly 170 fps. With  Batman Arkham 
Knight, the in-game benchmark reported a dismally 
low frame rate in the 40’s. Even crazier, I wasn’t 
seeing any SLI scaling at all. One Titan X, two Titan X, 
or four didn’t move the needle. All of my 
performance tests were in the mid- to low 40s. I tried 
the latest GeForce Experience optimizations and 
multiple reboots with nary a difference.

What’s up? I spoke with Nvidia officials who said they’re trying to 
figure out what my problem is, because they are seeing scaling 
internally. I’ll report back once we figure it out.

What about AMD?
Remember, this is the game running on Nvidia hardware, which 
traditionally has a leg up in performance and stability over AMD GPUs 
for this franchise. Many AMD users have also reported issues running 
the game. Even worse, the section of WB Games’ FAQ that discusses 
running the game on both AMD and Nvidia hardware reads like the 
fine print for a prescription drug that hasn’t yet passed FDA trials. 

The craziest part of Batman: Arkham Knight is that when it does run, it 
seems to run fine. In addition to running it on that Big Bertha Titan X 
system, I also ran it on Asus’ new ROG gaming laptop, which is 
outfitted with a GeForce GTX 980M. It ran just fine, with frame rates 
on the single card in the 60 fps range. That’s at 1080p resolution, mind 
you, but it makes it even more puzzling that the game ran so poorly 
on a desktop PC with a single Titan X.

Bottom line: WB Games made the right move in suspending sales.  
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BY HAYDEN DINGMAN

UP FRONT: THERE are going to be spoilers in this review. Or, at least, a 
few of you may deem them spoilers—I am going to actively discuss 
some of the villains in Arkham Knight. By name. And a few of the plot 
points. Why? Because there are very specific examples that I feel 
embody Arkham Knight’s failings, and it’s easier for me to just talk 
through them than talk around them.

Good? Good. Let’s dig in. 

Batman: Arkham Knight 
(PC): Holy squandered 
potential, Batman



Na-na-na-na-na-na-na-na-na 
Phew. Where to even start with Arkham 
Knight? I mean, we could take the easy route 
on this one and talk about how busted the 
PC port is. It is busted. I got a higher frame 
rate in The Witcher 3 on Ultra than I did in 
Arkham Knight, and I don’t just mean because 
of the console-esque, 30-frames-per-second 
cap the game shipped with.

You know what though? The PC version will 
get fixed. It might take weeks. It might take 
months. But I have no doubt eventually 
Rocksteady will fix it. Should it have been released this way in the first 
place? Absolutely not, and thus we’re not bothering to score this 
review. It is not a game in any condition to be scored. And, for that 
matter, it’s not even on sale anymore.

The technical problems with Arkham Knight have been a lightning 
rod, though. There are so many other issues with this game that have 
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nothing to do with its frame rate, its textures, any 
of that. Let’s discuss those instead.

Sure, it’s fun, but  Arkham Knight is not a great 
game. It is a collection of pretty great mechanics 
soldered onto some cringe-worthy dialogue, a 
pile of meaningless side missions, a decent main 
story, some truly illogical plot conceits, and so 
much forced vehicular action it’d be easy to 
forget this is a story about Batman.

Everything that is great about Arkham Knight 
has been lifted from Rocksteady’s previous two games—the 
incredible Arkham Asylum and the slightly-less-incredible-but-still-
good Arkham City. Embodying Batman in Arkham Knight is, frankly, 
fantastic. The trademark Batman combat has never been more fluid. 
Gliding around the city is considerably less janky than it was in Arkham 
City. And there’s a new move that involves ejecting out of the 
Batmobile at high speed and launching yourself a mile into the air 
before gliding around Gotham. It looks badass.

That is the last nice thing I am going to say about the Batmobile. 
See, the Batmobile is problem number one with Arkham Knight. 

Everything that is 
great about 
‘Arkham Knight’ 
has been lifted from 
Rocksteady’s 
previous two 
games. 



Rocksteady touted the Batmobile feature a ton prior to release, and 
now we know why: because it’s been forced into practically every 
single encounter in the game. Even Riddler’s missions. Riddler now 
constructs race tracks. No, I am not joking.

There are a few issues here. First of all, THE RIDDLER NOW 
CONSTRUCTS RACE TRACKS. This is something so magnificently stupid I 
can’t even fully come to grips with it.

Other missions have you fighting legions and legions of “drones”—
they’re tanks but they’re unmanned because Batman doesn’t kill!—
until your eyes glaze over. None of these missions are particularly hard. 
Just tedious. 

But the greatest sin of the Batmobile has nothing to do with the car 
itself. Rather, it’s the design direction the game took once it was 
apparently mandated that Batman’s biggest and most 
inefficient gadget had to factor into practically every part 
of the game. 

One of the best ideas in Arkham Asylum and  Arkham City 
was something I’ll refer to as the “Villain Lair.” In Asylum, this 

Riddler now 
constructs 
race tracks?!
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meant seeing how each member of Batman’s Rogues Gallery 
transformed their little section of Arkham—a fiefdom within Joker’s 
larger kingdom. Arkham City kept the same idea, except it expanded to 
villains’ owning entire buildings. “Here’s Penguin, holed up in a weird 
museum! Here’s the (infamous) Mr. Freeze section! Here’s Mad 
Hatter’s lair of Scarecrow-inspired dream sequences!”

Arkham Knight abandons this and squanders its villains, especially 
outside of the main story. Penguin is smuggling guns out of 
featureless warehouses. Firefly pulls the same “bust out of a building 
that’s on fire” move three times before deciding he’s been punched in 
the face enough to stay down. Man-Bat doesn’t even do anything—he 
just flies in circles until you decide to find him. Two-Face is robbing 
generic banks.

And Deathstroke—oh, poor Deathstroke. He doesn’t even get his 
own unique story line. One of the most fearsome villains in the DC 
Universe is relegated to a fourth-tier role here, as he takes over for 
another villain you’ve already confronted. Even worse? Deathstroke’s 
“boss battle” is a Batmobile-led tank battle that’s literally a copy-paste 
of a tank battle you already played earlier in the game.

Here is 
Penguin’s big 
lair. Looks...not 
very Penguin-y.
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Batman’s most iconic 
villains are just sort of…
doing nothing at all. Farting 
around committing petty 
crimes while the entire city 
is on the verge of extinction. 
God forbid Two-Face rob a 
few banks while Scarecrow is 
threatening to literally wipe 
Gotham off the face of the 
planet with fear toxin.

It feels empty. Tedious, 
even. And how did we get 
here? The other Arkham 
games somehow managed 
to make even lame 
characters (Calendar Man) 
seem interesting, or like you 
should know something 
about them. Here, even the 
franchise’s most iconic 
characters come off as 
buffoons (at worst) or just empty filler characters (at best). There’s 
nothing uniquely Penguin about smuggling guns, nothing uniquely 
Two-Face about robbing banks. And by placing them in these settings, 
you also miss out on the whole “Lair” aspect. Your final fight against 
Two-Face takes place in a bank that’s indistinguishable from the first 
two he robbed. There’s nothing there that screams “Two-Face.” No 
clever environmental storytelling.

Which is weird because the city of Gotham itself is just as over-the-
top as it was in Arkham City. There’s neon everywhere. All the buildings 
teem with unique art and visual design. It’s a creative, comic book–
esque take on the city and I love flying around it—but very few of 
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these buildings actually factor into the story in any interesting way. 
They’re just there to look pretty while you glide/drive around.

And I blame it on the Batmobile. I do. Arkham City had the same 
open-world setup as Arkham Knight, but it played completely 
differently. The city was essentially an enormous hub between the 
actual levels. Very little of the game took place in the city itself. 
Instead, you flew to wherever the next mission was, went inside, and 
then explored the building often for upwards of half an hour.

Arkham Knight is so afraid of letting you be inside, because what if…
what if you forget about the Batmobile? As such, probably 90 percent 
of the main story and 80 percent of the side missions take place in the 
city itself. And the rest? It’s mostly made up of quick hit-and-run 
beats. Two-Face’s robberies, for instance—you’re only inside for five to 
ten minutes, max. Then you’re kicked back onto the street.

The result is a game that feels unfocused, that feels like it’s shuttling 
you from empty mission to empty mission and discarding all its 
villains. Whereas Arkham City felt like it had potentially too many 
villains, Arkham Knight feels like it has too few—or at least too few that 



matter. It’s basically Scarecrow (the main baddie) and the titular 
Arkham Knight. Everyone else is disposable.

Luckily Scarecrow carries some of the narrative weight, thanks to an 
excellent, truly wonderful performance by John Noble. Unfortunately, 
it’s a Star Wars situation where you have a talented actor reading utter 
farce. On the other hand, he’s so menacing you can forgive the 
occasional plot hole or telegraphed twist.

Sorry, when I said “occasional plot hole” I meant “Arkham Knight’s plot 
is silly.” Even with the spoiler tag above, I don’t want to kill the whole 
plot for you.

But let’s just say there’s a point where Scarecrow announces his big 
backup plan…and it’s to cover Gotham in fear toxin. A Gotham that’s 
already been evacuated. A Gotham that is only populated by a handful 
of police, Batman, Alfred, and a whole bunch of villains.

Go ahead, Scarecrow. Gas the city. See if I care. 

Bottom line 
The thing about Arkham Knight, about reviewing Arkham Knight, is I 
didn’t even hate the game. It’s a summer blockbuster. It’s soda and 
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popcorn. It’s something that goes down smoothly 
(aside from the stupid tank sections), but at the end 
you’ve consumed nothing at all of value.

I’m not going to say that Arkham Asylum and 
Arkham City were particularly smart games, but they 
were smart superhero games. Take the grit of Nolan’s 
Batman, combine it with the eye-candy of Tim 
Burton’s Gotham, and you’ve got one hell of a take 
on the dark knight. The Arkham series was great 
because it played to Batman’s strengths—his 
brutality, his knack for inducing fear, his cleverness, 
and (most importantly) the unique and twisted 
personalities of his villains.

Arkham Knight doesn’t do those things. It doesn’t 
let Batman be Batman. It doesn’t let Batman’s 
villains be villainous. With the exception of a single 
plot thread it squanders two games’ worth of setup 
and replaces much of what I loved about the series 
with pointless filler. Filler I completed. Filler I even 
sometimes enjoyed on a purely mechanical level—
crawling through vents and silently taking down henchmen as Batman 
is as satisfying as ever.

But too often I felt like Arkham Knight was a professional athlete 
post-retirement: Bloated, unfocused, and always boasting about a 
really nice car.  
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NTEL’S FIFTHGENERATION BROADWELL CPU has been the 
default laptop processor of choice since its debut in January, 
but it’s been difficult to get a real bead on just how much of 
an improvement it was on its Haswell predecessor.  

 That’s because unlike desktops, where it’s easy to control 
the environment they run in, laptops are complete packages. I tried  
to compare the updated ThinkPad X1 Carbon with Broadwell to the 
Haswell ThinkPad Carbon X1, for instance, but it wasn’t quite apples-
to-apples. I initially determined that the Broadwell CPU was 
significantly faster than the Haswell. Something didn’t ring right, 
though, and ultimately I decided Lenovo’s redesign of the laptop likely 
contributed to the results and really made it useless to try to draw any 
conclusion on the CPUs themselves.  

My second chance came when I found upon two laptops that were 
identical—save for the CPU. Dell’s commercial Latitude E5250 at one 
point simultaneously shipped with Haswell and Broadwell parts.   

I

The Dell 
Latitude 
E5250, at one 
point, came in 
both Haswell 
and Broadwell 
trim, making it 
perfect for 
testing. 
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THE COMPETITORS  
The chips are very close. The Haswell-based E5250 uses an Intel Core 
i5-4310U, a dual-core chip with Hyper-Threading and a rated clock 
speed from 2GHz to 3GHz. The Broadwell-based E5250 has a Core 
i5-5200U that’s also a dual-core with Hyper-Threading and ranges 
from 2.2GHz to 2.7GHz. While the Broadwell’s base clock speed is a 
little higher, its top speed is a bit lower. Perhaps more importantly, 
both CPUs are also the same price.  

 For graphics, the Broadwell has Intel HD 5500, while the Haswell 
has Intel HD 4400 graphics. If you want to see more details of the two 
CPU competitors, I’ve lined them up at Intel’s ARK site (go.pcworld.
com/ark).

Everything else, from what I can tell, is the same. Both feature 
touch-panel, 1920 x 1080-resolution dis-
plays, 256GB Samsung mSATA PM851 
mSATA drives, 8GB of DDR3L RAM in single-
channel mode, the same 51-watt-hour 
capacity batteries, and the same Windows 
8.1 OS. In fact, both even use the same moth-
erboard, which I visually confirmed by open-
ing up both E5250 laptops. The only difference in the motherboard is 
one has a Haswell soldered down to it, while the other has a Broadwell 
soldered down to it. This is no surprise: Intel designed the Broadwell to 
be “drop-in” compatible, and many makers did just that.  

THE TESTS  
For benchmarks, I stuck with tests that would isolate the CPU 
performance as much as possible. First up is the pure CPU benchmark 
Cinebench R15, which measures a chip’s performance rendering 3D. 
The performance, for the most part, is very close—but surprise, the 
Haswell chip actually wins here. I suspect that’s because the single-
threaded mode gives the Haswell chip a small advantage due to its 
higher clock speed when on Turbo Boost mode. The Broadwell tops 
out at 2.7GHz versus the 3GHz of the Haswell chip’s top speed. That 
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Single-threaded 
performance is very 
close—but surprise, the 
Haswell chip wins here. 
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gives the Haswell chip about a 10 percent clock speed advantage.   
 The good news for Broadwell is that its improvements in perfor-

mance close the clock speed gap. Despite that roughly 10 percent 
clock speed difference between the two, the actual performance gap 
in Cinebench R15 is closer to 5 percent.  

CINEBENCH 3D RENDERING 
PERFORMANCE  
What happens when you run CineBench R15 in multi-threaded mode, 

CINEBENCH R15 MULTITHREADED PERFORMANCE
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threaded mode 
measures CPU 
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slower on  
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ed tasks than 
the Haswell 
chip, the 
Broadwell 
makes up for it 
in multi-
threaded per-
formance.
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though, where it measures the overall performance of all the cores in a 
CPU? We see the Broadwell come back to edge out the Haswell chip. 
This is because, while the Broadwell chip is slower in overall clock 
speed when only one core is working, it runs a little cooler (thanks 
to its 14nm process). The Haswell has an advantage in the beginning, 
but as it heats up, it starts to throttle back on frequency so it’s only 
about 100MHz faster by the end of the test. Combined with the 
better efficiency of Broadwell, it’s just enough to make the 5th-gen 
chip barely faster here.  

PCMARK 8 OFFICE PERFORMANCE 
 I also ran PCMark 8’s Work test using the conventional setting. This 
keeps the workload to the CPU side instead of using a little of the 
graphics core for some tasks. PCMark 8 Work test is designed to 
simulate tasks such as videoconferencing and general-office droning.   

 PCMark 8’s not heavily multi-threaded like CineBench and doesn’t 
heat up the Haswell enough to make throttling a big problem. The 
Haswell CPU’s slightly higher clock speed gives it the advantage here, 
but for the most part it’s not enough to write home about. It’s actually 
a fairly realistic evaluation of the low demands of mundane office 
tasks: The dual-core Haswell laptop scores 2,922. Consider that a 
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tested desktop (not shown here) with a six-core Core i7-5820K scored 
3,321. That tells me PCMark 8’s right on the mark for office tasks and 
you don’t need that many cores for office work.   

HANDBRAKE ENCODING 
PERFORMANCE  
 Looking for a heavier-duty task, I also threw in our standard encoding 
test, where we take a 30GB, 1080p MKV file and use Handbrake to 
transcode, using the Android for Tablet profile. On dual-core machines, 
it takes in excess of two hours to complete.  

This test gives us two really useful data points. The first is how well 
a particular CPU performs in this heavily multi-threaded test. Short of 
an 18-core CPU with 1080p resolution files, it’ll max out all cores.   

 The second data point you get from this test is how much the 
design of a laptop suffers from thermal throttling. Modern CPUs are 
designed to slow down when they get too hot or if the PC maker 
determines it’s heating up the entire laptop too much. For example, if 
you look at the Handbrake test in my recent review of the Lenovo 
LaVie Z (go.pcworld.com/lavie), you can see how much certain PC 
designs will throttle back the CPU’s speed—the review’s Handbrake 
chart shows the impact of thermal throttling from the Surface Pro 3 

HANDBRAKE 0.9.9 ENCODE SEC
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and the Lenovo ThinkPad X1 Carbon, both of which have the same 
CPU. If you look at the result from the HP Spectre x360 and compare it 
to the Dell XPS 13 that has the same CPU, you also see the 
performance drop off to aid and abet the cooling capability of the 
laptop (or the decision by the laptop maker not to heat it up too 
much). 

With all that said, let’s now look at the results from the Broadwell 
and Haswell units. Both use the exact same cooling system, from what 
I could tell looking inside both. The Broadwell technically loses here, by 
less than 1 percent. But when you remember that the Haswell 
technically has the higher clock speed, it’s actually a win for the 
Broadwell to be so close.   

3DMARK GRAPHICS PERFORMANCE  
 While Intel says Haswell-to-Broadwell performance shows maybe a 5 
percent difference on CPU functions, on graphics the company says 
the spread’s more significant. That shows up in 3DMark, where the 
Broadwell-chipped Dell offers up about 10 percent more graphics 
performance in Cloudgate. I even saw a 15 percent difference 
between the two when the graphics load is scaled back further to 
3DMark Ice Storm Extreme. Don’t fool yourself—you won’t be playing  
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Batman: Arkham Knight at 4K with either CPU, nor any recent graphics-
intensive game, but a game of Minecraft, Counter Strike, or Portal 2 with 
the settings turned down enough are playable.

My last benchmark chart for the mobile dual-cores is the most 
important one for the applications in an ultra-portable laptop. Let’s be 
realistic: People aren’t encoding 4K video or playing Battlefield 4 on 
these laptops, they’re pushing browsers, Office, and maybe Photoshop, 
or coding on them. All within the performance envelope of a dual-core 
processor. What people care about most is the battery life.

MobileMark 2014’s Office Productivity battery test uses common 
applications such as Word, Acrobat, and Chrome to simulate a day of 
pushing mundane office tasks while on a battery. The test even lets 
the laptop go to sleep for a few minutes, when the typical office drone 
might be checking their phone or chatting to the person in the next 
airplane seat.  

Here we see the 14nm Broadwell CPU pay off very healthy 
dividends over the 22nm Haswell CPU. Remember, both laptops use 
the exact same-capacity battery, SSD, OS, and just about everything 
else. For the record, the RAM chips were different, as were the battery 
makers, but they used the same specifications.  

MOBILEMARK 2014 OFFICE PRODUCTIVITY 
BATTERY LIFE MIN
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With all things being equal, a 10 percent improvement in battery 
life is significant when you consider that Haswell was already an 
outstanding performer. Haswell significantly moved the ball forward 
over Intel’s 3rd-generation Ivy Bridge CPU. Matt Smith actually did a 
somewhat similar test (go.pcworld.com/smith), pitting an Ivy Bridge 
laptop against a Haswell laptop. Both laptops were similar, but Haswell 
CPUs required a wealth of new components such as chipset and 
voltage changes, so comparisons don’t really isolate just the CPU.

I’m fairly certain that if the laptops used here had CPU sockets and I 
could switch the chips, my results would be the same.  

CONCLUSION  
Broadwell cuts both ways. Broadwell is better than Haswell by 5 
percent to 10 percent or so on a given task when the CPU models are 
exactly the same. Battery life is better by 10 percent or so. Graphics 
performance is much improved, but it’s still just integrated graphics, 
best suited for office dronage or low-ambition gaming.  

If you were to buy a laptop today, Broadwell is the way to go—if 
your options are between a Broadwell-based CPU and a Haswell-based 
one at the same price.  

If you have a Haswell-based laptop, however, there’s no point in 
upgrading to Broadwell. I don’t expect that many people who bought 
a Haswell-based laptop in 2014 are deciding to upgrade to one with a 
Broadwell CPU a year later just for the CPU. They might upgrade for 
pen support, a better screen, or a larger SSD or keyboard, however.  

This information is really aimed at those using even older, 
2nd-generation Sandy Bridge CPUs or 3rd-generation Ivy Bridge CPUs. 
Moving to a modern Broadwell laptop would deliver significant 
improvement in battery life and clock-for-clock performance, not to 
mention all of the other advances in screen quality, touch, and SSD 
support. For those replacing an older laptop, Broadwell is the better 
CPU, and our tests prove it. 
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5 free Wi-Fi 
tools that help 
maximize your 
home network
 BY IAN PAUL
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Wi-Fi made more wonderful
Forget about sliced bread—Wi-Fi is easily one of the 

greatest inventions of the last few decades. Thanks to 

Wi-Fi every device in your home can easily get online, 

whether it’s your iPad, desktop PC, the high-definition

television in the living room, and maybe even your 

coffee pot or fridge.

But are you getting the most out of your wireless

Internet connection? Is it truly as fast as your service

provider claims? Are the neighbors screwing up your 

signal? Do you know how to connect all your various 

devices together to share files at home?

Here are five free Wi-Fi-enhancing tools that can

help you answer “yes” to all of those questions.
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Channel changers
Sometimes getting a better Wi-Fi signal is as simple as 
changing the channel. If you live in a densely populated area 
such as an apartment or townhouse complex, you are 
probably surrounded by dozens or even hundreds of 

individual Wi-Fi routers. Each one is broadcasting a signal to help its owner get 
online. The problem is that sometimes a bunch of closely situated routers can 
end up interfering with each other.

When that happens you can help yourself out by changing your router’s 
broadcast channel. To help you find an ideal channel (read: the least populated) 
use ViStumbler (vistumbler.net) on Windows to get all kinds of data on the Wi-Fi 
routers around you. Or you could give Wifi Analyzer (go.pcworld.com/
wifianalyzer) for Android a try—this is also a great option to test signal strength 
at different points in your house.

 1.
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Speed test
The golden rule of Wi-Fi service is to never believe the speed 
promises your Internet Service Provider makes, at least not 
without checking. That’s where Ookla’s Speedtest.net 
(speedtest.net) comes in. This simple service quickly checks 

your network speeds in an easy to understand format that highlights your 
download and upload speeds.

There are also mobile apps for Android, iOS, and Windows Phone, which is 
handy when you want to quickly check out your hotel Wi-Fi speeds, or even 
what kind of speeds you can get in the attic.

 2.
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Transform your PC into a hotspot
It’s easy to let your phone or tablet become a Wi-Fi hotspot 
that other devices can connect to, since most modern 
mobile operating systems come with a one-click solution to 
make this happen. Your laptop or desktop PC, however, does 

not. There are built-in methods for various builds of Windows, but they are 
either a little complicated or involve jumping onto the command line. (Ugh.)

To get around this there are many third-party apps you can download to 
make your PC a 
hotspot, including 
Connectify 
(connectify.me), 
MyPublicWiFi 
(mypublicwifi.com), 
and Virtual Router 
(virtualrouter.
codeplex.com).

 3.
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Chrome Connectivity Diagnostics
So you’ve tried changing channels, but you’re still having 
issues with your Wi-Fi. Google has a Chrome app that can 
help called Chrome Connectivity Diagnostics (go.pcworld.
com/chromeconnectdiag). This app runs a number of tests 

on your laptop’s current Wi-Fi connection to determine whether you have an 
Internet connection available to you, a DNS connec tion, and the right ports 
open on your laptop, and then it runs a bunch of checks with Google products.

If there are any issues you’ll see them at the top of your window under a 
heading called Warning Tests. As you can see, my network was having issues one 
day with a slow 
connection. Click 
the problem and 
you get a summary 
of what’s going on. 
There are also 
some Chrome OS–
only features 
including Wi-Fi 
network strength 
and whether your 
default gateway is 
reachable.

 4.
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Transfer files
Part of the beauty of Wi-Fi is that you have a variety of 
devices all over the house and they are all connected to the 
same network. Getting those devices to talk to each other, 
however, is not so simple—unless you know about the right 

software to use.
The simplest option for PCs is just to use the Windows HomeGroup (go.

pcworld.com/win7homegroup) feature first introduced in Windows 7. This will 
let you share printers, music, videos, and documents. For mobile devices, tools 
like AirDroid (go.pcworld.com/airdrodmirroring), Pushbullet (go.pcworld.com/
pushbulletportal), 
and Dooblou WiFi File 
Explorer (go.pcworld.
com/dooblouwifi) 
can help move data 
to a PC. Finally, if you 
want to keep a folder  
or set of folders  
in sync, then your  
best option is 
BitTorrent Sync (go.
pcworld.com/
bittorrentsync).

Some of these 
tools don’t 
necessarily require 
you to be on the 
same network, but 
things tend to go 
faster when they are.

 5.
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Make your Gmail inbox more productive with experimental  
add-ons like Undo Send, Canned Responses, and more.

How to build, maintain,  
and fix your tech gear.
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4 Gmail Labs features  
you should be using
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A S POWERFUL AS Gmail is, you can make it even more 
productive with add-ons from Gmail Labs. If you’re new 
to Labs, it’s the testing ground for Gmail’s more 
experimental features. The successful ones go on to 

become standard Gmail capabilities—the much-loved Send & Archive 
button was once a Gmail Lab experiment—but while they’re in the 
Labs, there’s always the outside chance they could break, change, or 
disappear.

To enable any Gmail Lab feature, click the gear icon in the top left of 
the Gmail pane. Go to Settings → Labs. Scroll down to the feature you 
want, select the Enable radio button, and click Save Changes. Should 
you run into trouble using any of these, you can get to your email by 
going to https://mail.google.com/mail/u/0/?labs=0, which disables 
these features so you can reach your inbox.

Assuming you’re comfortable being Gmail’s guinea pig, here are four 
Google Labs features you should experiment with yourself.

Undo Send
Whether it was a simple snarky remark or a seething message, we’ve 

Gmail Labs calls 
its features 
“some crazy 
experimental 
stuff.”
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all felt the pang of regret after sending an email we probably shouldn’t 
have. If you just can’t control your impulses, Gmail’s Undo Send feature 
can save you from having to eat a heaping helping of humble pie.

This feature will delay sending your email messages 5, 10, 20, or 30 
seconds, giving you a grace period during which you can hit an Undo 
button and prevent your missive from going out. Once you’ve enabled 
it, just set your Cancellation Period on the General tab under Settings.

Canned Responses
We all have certain email replies that we send over and over—“busy” 
responses, receipt confirmations, and away messages, for example. 
Google Labs Canned Responses lets you pre-write and save these 
evergreen messages so you can send them with one click.

Once you’ve enabled this feature, creating a canned response is 
simple. From your inbox, click Compose, and type a reply you want to 
save. Next, click the arrow in the lower right corner of the message 
window and select Canned Responses → New Canned Response. Name 
the response, and click OK. When you want to use a canned response, 
click the arrow again from the message you’re replying to, and select 
Canned Response, then the name of the one you want to insert.

Once you 
enable Undo 
Send, configure 
your 
cancellation 
period on the 
General 
Settings tab.

Canned 
Responses lets 
you insert 
common replies 
with one click.
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Preview Pane
One downside to Gmail is you have to open a message to see its 
contents, which is a time suck when you’re trying to browse through 
your inbox. Preview Pane gives Gmail’s web interface the multipane 
view we’ve become accustomed to on most desktop email clients, and 
let’s you view messages as you scroll through them.

When you enable this feature, a new button will appear next to the 
gear icon in your inbox. From here you can toggle Preview Pane on and 
off and select either a vertical or horizontal orientation.

Auto-advance
If you’re processing your emails in bulk at designated times rather 
than as they arrive—as you should be—you know it’s a drag to have to 
return to your inbox after handling each message to select the next 
one. Auto-advance saves you time by automatically moving to the 
next oldest message (if you process your inbox from the top down) or 
next newest (if you process from bottom up). You can configure your 
preference on the General tab under Settings. 

HERE’S HOW

Preview Pane 
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SO, WHAT ELSE can Excel do? People ask this question all the time. The 
answer is “almost anything.” Excel has evolved into one of the most 
versatile programs available. In addition to spreadsheets that calculate 
everything, it’s also a database, a programming tool, a graphics program 
with charts, tables, drawing tools, photos, clipart, and even layout 
abilities, and it’s a limited, but functioning, word processor (with a spell 
checker, Thesaurus, grammar tools, research capabilities, translation 

BY JD SARTAIN

Excel’s best tricks:  
How to make a calendar
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functions, and more).
With its graphic features, you can create anything from a detailed 

drawing to an edited photo. You can make calendars, note pads, list 
pads, schedules, grid/graph paper, greeting cards, business cards, etc. 
If you’re wondering why anyone would use 
Excel over programs such as Photoshop and/
or Illustrator, the answer is simple. Not 
everyone has access to graphics and/or photo-
editing software. And, although Windows 
includes PC Paint as an Accessory program, it’s 
actually easier—in many cases—to use Excel 
for some projects. .

How to start your calendar
Open a blank worksheet. Highlight Columns A through G, then roll 
your cursor down to extend the highlight through Row 7, making the 
range A1 through G7. From the Home tab, select the Cells group, and 
click Format → Column Width. Type 18 in the Column Width dialog box, 
then click OK. With the range still highlighted, select the Cells group, 
and click Format → Row Height. Type 75 in the Row Height dialog box, 
and click OK. Move your cursor to the Home position, A1. Change the 
Row Height to 118. Cursor down to A2 and change the Row Height to 
30.

Highlight the range A1 through G7 again. Select the Page Layout 
tab, choose Orientation from the Page Setup group, and click 
Landscape. Next, click Margins from the same tab and group, and 
select Custom Margins from the list. The Margins tab in the Page 
Setup window appears. Press the Tab key once, and your cursor moves 
to the first setting: Top.

TIP: It’s so much easier and faster to just tab and type through these 
settings, rather than trying to highlight each field box and cursor the 
up/down arrows.

In the Top field box, type .25, then press the Tab key and your cursor 
moves to Bottom. Enter .25, press the Tab key, cursor moves to the 

HERE’S HOW

With Excel’s graphic 
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Left field box. Enter .25, Tab to the Right field box, enter .25. Press the 
Tab key, cursor moves up to Header, enter 0. Then tab again down to 
Footer, and enter 0. Press Tab again, and the cursor moves to the 
Center on Page panel. Check both Horizontally and Vertically, then 
click OK.

With the area still highlighted, click Print Area → Set Print Area from 
the same tab and group. It looks like nothing happened, but press the 
Home key once, and notice the solid (or dotted) line around the area 
you just selected. This is the area of your spreadsheet that Excel 
prints, as long as you don’t change the Print Area to something else. 

1. Select range, 
adjust column 
and row size.
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Highlight a new area: A2 
through G7. Click the Borders 
button in the Fonts group, 
under the Home tab, then 
choose All Borders from the 
drop-down list.

Enter the days of the week in 
Row 2 (A2:G2), center 
horizontally and vertically, then 
enter the days of the current 
month on the calendar. Next, 
merge the top cells into one. 
Highlight Row A1 through G1, 
then select Merge & Center 
from the Merge button under 
the Home tab, Alignment 
group. Now, let’s add a fancy 
title (June 2015). Click Insert → 
Text → WordArt and choose a 
style for your text , then type 
June 2015 in the field box. 

If you’d prefer a more ornate 
month and year, try some 
clipart. Delete the WordArt, 
then select Insert → Illustrations 
→ Online Pictures, and type June 
in the search box. Choose an 
image for the title, then size to fit. Next, add some clipart images to 
decorate your calendar. Select Insert → Illustrations → Online Pictures 
again, type Summer in the search box, then choose from the filtered 
selection. Size to fit in the space provided. Note: Sizing down is usually 
no problem, but enlarging (or sizing up) will likely result in a blurred 
image. 

If you happen to select an image with unwanted areas, such as a 
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2. Page Setup 
and Borders for 
your calendar.
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picture with the wrong year, you can crop the image to remove that 
element, but only if it’s standing alone beside a border. First, the 
image must be selected so the Picture Tools/Format menus are 
displayed. Select Format → Crop → Crop. Notice the black “handles” 
around the image. Put your mouse cursor on one of the handles, hold 
down the left mouse button, and then slide the handle up, down, or 

3. Merge cells 
and insert 
WordArt.
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over to crop out the unwanted sections. When satisfied, click 
anywhere outside the image borders and the image is cropped.

Next, size and place. But the background is blue, and you want a 
transparent background. No problem. Select the image, (the Picture 
Tools/Format menus appear). Choose Format → Remove Background → 
Mark Areas to Keep. Use the handles on the image to adjust the 

4. Use 
WordArt or 
clipart to enter 
the month and 
decorate the 
calendar.
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5. Crop unwanted parts out of the images.

border around the parts of the 
picture you want to keep. 
Since you’ve already cropped 
it, just stretch the borders 
towards the center, then click 
outside the image area and 
it’s done. The background is 
transparent, the wrong year is 
cropped out, and it’s sized to 
fit in the header space above 
your calendar.

Last, add holidays and any 
special occasion days such as 
birthdays, graduation, or 
anniversaries. To add text to a 
date, position your cursor on 
the target date; for example, 
June 12th. Press the function 
key F2 to edit this cell. The 
cursor positions to the right 
of the number 12. Because 
the numbers are on the 
bottom-right corner—unless 
you want to change that—
press the Home key to reposition the 
cursor before the day.

Now type the name of the occasion, 
then press Alt+Enter (hold down the 
Alt key, then press the Enter key, then 
release both keys), once for each 
additional line added—in this case, 
once to separate the text from the number, then three more times to 
move the text to the top of the calendar box. Now the data is on the 
right. No problem, just click the Align Right button on the Home tab, 
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6. Size, place, 
and remove the 
image 
background.

7. Add special occasion 
days. Note: the image is 
cropped to fit this page. The 
original is a complete seven-
day calendar.

Alignment group and the 
data moves to the right.

Note: You cannot right-
justify the number, then 
center or left-justify the 
text, because Excel doesn’t 
allow multiple paragraph 
styles in the same cell. You 
can click the Increase 
Indent button (also in the 
Alignment group) to move 
the data two pixels away 
from the right border. But 
you can use multiple font 
attributes such as Bold for 
the number and Italics or a 
different color for the text. 
Press F2 to edit, then 
highlight the number or the 
text and choose a new color 
or attribute. If you want both the same, then just position 
your cursor on that cell and choose an attribute and color. 
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WHEN A BIG website like Lenovo’s gets hacked, it’s news. But most 
such attacks take place under the radar, at smaller sites lacking the 
skills or time to protect themselves. Take the legions of WordPress-
based sites, which got a rude awakening last year when many 
thousands (go.pcworld.com/thousands) of them were hacked. 

BY ROBERT LEMOS

The 3-step plan to make your 
website hard to hack
Online attackers are increasingly targeting websites. 
Protecting your online brand requires vigilance.


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Don’t be one of those sites. Even if you don’t use WordPress, you can 
learn important lessons from what those poor blighters have been 
through.

The un-magic bullet: site maintenance
Quickly spinning up a WordPress site on a hosted server is simpler than 
ever, but users need to understand that the sites require regular 
management. Cybercriminals and hackers are continuously looking for 
sites whose administrators use easy-to-guess passwords, inadvertently 
misconfigure the site, or fail to apply the latest patch.

Earlier this year, for example, security firm Zscaler found that 
compromised WordPress websites were forwarding visitors’ login 
credentials (go.pcworld.com/zscaler) to an attacker-controlled site. 
Last year, in one of the worst cases of serial compromise, a malicious 
program, known as SoakSoak, infected (go.pcworld.com/infected) 
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WordPress 
accounts for 
about a quarter 
of all websites 
and 60 percent 
of all CMS-
powered 
websites.

WORDPRESS

24.2%

60.3%

JOOMIA

2.8%

7.1%

DRUPAL

2.1%

5.1%

MAGENTO

1.1%

2.9%

BLOGGER

1.1%

2.8%

W3TECHS.COM

Types of Web site platforms in use

Percentage of all 
Web sites

Percentage of 
CMS-powered 
Web sites
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more than 100,000 WordPress sites using a vulnerability in a popular 
plugin. “The beautiful thing about these applications is that they are 
easy to use and make it easy to get a website up online,” Tony Perez, 
CEO of Sucuri, says. “But it’s a double-edged sword—we cannot 
depend on the users to be able to manage the sites securely.”

Security experts don’t blame the content 
management systems, which typically take 
security seriously. But WordPress sites 
account for 24 percent of all websites, and 
Joomla and Drupal account for another 5 
percent, according to Web technology firm 
W3Techs. The software is under intense 
attacker scrutiny. Attackers have historically 
tried brute-force password guessing as a first 
assault on content management systems, followed by quickly 
attempting to take advantage of any just-published vulnerabilities.

Passwords are an easy problem for users to solve, but keeping up 
with a steady stream of vulnerabilities and patches requires diligence, 
says Mark Maunder, CEO of WordPress security firm Wordfence. These 
three best practices will help you fend off attackers.

1. Update as soon as possible
Anyone managing their own site should either use a hosting service 
that manages the core content management system (CMS) updates 
or create a process to keep up with information on vulnerabilities that 
could impact their installation.

Be warned, it’s a tough job. Subscribing to any vulnerability feeds for 
their software and plugins is a necessity to quickly patch 
vulnerabilities in either the CMS or its plugins. Yet, it’s easy to be 
inundated, says Sucuri’s Perez.

“It is almost impossible for developers to keep up with 
vulnerabilities,” he says. “They are trying to run their site, and trying to 
keep track of all the patches and applying them is difficult.”

Web-security services like Sucuri, Cloudflare and Incapsula can buy 

Security experts don’t 
blame the content 
management systems, 
which typically take 
security seriously.
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administrators more time to patch their sites, by blocking known 
attacks.

2. Don’t forget your plugins and themes
While keeping the main content management system up-to-date is 
challenging, patching every plugin can be a more onerous burden, as 
attackers have increasingly targeted vulnerabilities in plugins and 
themes to compromise websites.

“In general, attackers are trying to own as many WordPress sites as 
possible using as many zero days or recently-disclosed vulnerabilities, 
and then using that site for other attacks,” says Wordfence’s Maunder.

A variety of WordPress plugins provide security. Wordfence, 
BulletProof Security and iThemes Security perform a variety of 
security-related tasks, from scanning websites for compromises to 
setting the security controls of a WordPress site to harden the 
software against the most common attacks.

3. Regularly maintain your website
Having a hosted website is a responsibility and requires frequent 
maintenance. Administrators should back up the site, and make sure 
the backup is copied off the Web server—many inexperienced 
administrators overlook that step, says Maunder.

If you don’t have time to do this, go with a fully managed site. 
WordPress.com has a wide variety of templates and more flexibility 
than ever before. For other content management systems, such as 
Joomla and Drupal, a hosted service provider can manage the CMS on 
that server and help keep your website patched. 

HERE’S HOW
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HASSLE-FREE PC

THIS ONE’S FOR the anti-clickers. Despite fast Internet connections and 
zippy PCs, web designers still like to organize really long content into 
multiple pages. That can be for financial reasons (more clicks equals more 
ads thus more revenue) or just because the designer thinks it’s more 

Turn multipage web articles 
into a single, scrolling page 
with this extension
Autopagerize is an add-on for Chrome and Firefox that automatically 
loads the next page as you scroll.





manageable for the reader. 
Visual content in particular suits 
itself well to slideshows.

But the downside for the user 
is you have to constantly click 
through to the next page, 
whether it’s a Google search, or 
a lengthy news article. All that 
clicking can interrupt your 
concentration.

There are a whole bunch of 
add-ons that try to solve this 
problem. To save you a few clicks 
they automatically load multi-
page content while you scroll. 
I’ve been trying out a bunch of 
these add-ons. Some work really 
well, some don’t work at all, and some seemed a little sketchy.

I’ve settled on one that I think you should try out: Autopagerize 
(autopagerize.net). This add-on is available for both Chrome (go.
pcworld.com/autopagerizechrome) and Firefox (go.pcworld.com/
autopagerizeffx) and works very well on many major sites.

Unfortunately, it doesn’t work on PCWorld, but it will work on more 
general sites like Amazon and Google. The add-on is pretty simple. You 
just install it and it starts doing its thing. If it works with a site you’ll 
find out pretty quickly. Just sit where you’d normally click to the next 
page, wait a few seconds, and if the next page shows up then you’re 
good to go.

The downside to this add-on—and this appears to be a trend for this 
category of app—is that it hasn’t been updated in a while. The most 
recent versions of Autopagerize are from late 2014. So don’t expect 
rapid improvements to the number of sites this extension works with 
or a full set of customization options.

Still, it’s an add-on worth having for those sites it was designed for. 

Autopagerize 
saves you a 
click on major 
sites like 
Google.
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5 ways to add SSD speed to 
your laptop without losing 
storage capacity
Using an SSD and a hard drive together offers both speed and 
storage space. But most laptops won’t let you install two drives.

ANAND PRABHU ASKED if there’s a way to put an SSD and a hard drive into 
the same laptop.

A flash RAM-based SSD gives your PC amazing speed, but it’s 
expensive by the gigabyte. An old-fashioned, spinning-platter hard 
drive gives you vast amounts of storage for very little money. But if 

BY LINCOLN SPECTOR
HERE’S  
HOW

ANSWER LINE
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you use both, and set them up (go.pcworld.com/setup1) intelligently, 
you can enjoy a hard drive’s mass storage without losing too much 
performance. But that only works if you can install two drives into your 
PC. That’s usually an option only in larger laptops. Some laptops, even 
affordable ones, support the standard 2.5-inch hard drive/SSD and also 
have the options to support the flash-only mSATA  or M.2 drives. The 
PC makers then fill the bays depending on what you buy. This still 
leaves the option for you to populate the mSATA and run the hard 
drive, too. But let’s assume you probably have the 
typical laptop that only has a single drive bay 
supporting one hard drive. Here are five solutions:

1. A two-in-one hybrid drive
Devices like Western Digital’s WD Black²  (go.
pcworld.com/wdblack2) put two drives—an 
SSD and a hard drive—into one container 
with one SATA connector. For instance, the 
Black² has a 120GB SSD and 1TB HDD. Thus, 
you can have speed and mass storage 
together.

But these hybrids have their problems. 
They’re difficult to install, and often require 
special software for setup. And you can’t just clone your hard 
drive to the hybrid; you must move Windows to one drive and most of 
your data to the other. That can be tricky (go.pcworld.com/tricky). 
Worse, these drives tend to be 9.5mm thick, which means they don’t 
fit in all laptops.

2. A cached hybrid drive
Like the two-in-one, these drives mix both technologies, but in a very 
different way. Drives like those in Seagate’s SSHD (go.pcworld.com/
seagatedrive) line use flash RAM as a cache to speed up the hard drive. 
Because they’re seen by the PC and by Windows as a single drive, you 
can simply clone the old drive to the new one.

WD Black²
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They come in all thicknesses. You’ll almost certainly find one that fits 
in your drive bay.

On the other hand, they’re not as fast as a two-in-one hybrid.

3: An internal SSD and an external hard drive
This is the cheapest and easiest solution, but it’s also the slowest and 
rather unwieldy. Install an SSD into your laptop, put Windows, your 
programs, and your frequently-used data files there.

Then put everything else on an external hard drive.
Don’t even consider this unless your laptop has a USB 3.0 port, and 

make sure you have a USB 3.0 drive, as well. USB 2.0 is painfully slow for 
this sort of work.

And remember to use a different external drive for backup (go.
pcworld.com/different).

4: Network-Attached Storage
You can buy a Network-Attached Storage (NAS) device, install one or 
more hard drives inside, and connect it to your router. Thus you can 
access your files over your network. Most modern NAS systems also 
provide a private cloud, so you can access your data over the Internet, 
as well.

An NAS will probably be faster and more convenient than an external 
drive—once it’s working properly. But it will almost certainly be 
more expensive and more difficult to set up and if you 
work remotely, access to files will be problematic.

5: Buy a large SSD
Yes, they’re expensive—about $300 for 960GB as I 
write this. But this is the fastest and simplest 
solution. 

Have a tech question? Ask PCWorld Contributing  
Editor Lincoln Spector.  Send your query to  
answer@pcworld.com
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Tech Spotlight
A video showcase of  

the latest trends  

Exiii Hackberry 3D-printed 
hand: $200 affordable prosthetic

» Unlike high-cost, mass-market prosthetics, 3D-printed hands can be 
quickly repaired and have custom designs and features such as NFC 
modules in the fingertips, which could do everything from unlocking 
smart locks to authenticating mobile payments. Exiii engineers are 
testing an infrared muscle sensor to control the limb. It’s buggy, but it’s 
cheap and simple to set up.

Watch the  
video at

go.pcworld 
.com/ 

3Dhandvid
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